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CPN (Colored Petri nets)

* CPNis the language developed by Kurt Jensen et al.

 CPN supports the extensions with time, color and
hierarchy.

* CPN is based on standard ML.
* CPN is supported by Design/CPN and CPN Tools.

* In 2010, the support and further development of CPN
Tools moved from Aarhus University (Denmark) to
TU/e.

* Version 3 was the first version released by TU/e.
 For more information: http://cpntools.org
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Values and types

« Syntax Is needed to type places and give values
(colors) to tokens.

 Adopted from Standard ML

Outline:

* Basic types: int, string, bool, (real), and unit.
« Type constructors: with, product, record, list.
« Defining constants.




Basic types

Integers (int), e.q., 5, 34234, ~32423.

Reals (real), e.qg., 34.34, ~23.0, 7e3, 4e~2.
Strings (string), e.g., "Hallo", "28-02-2003".
Booleans (bool): true and false.

unit: type with just one value ()

» ~32423 means -32423
» ~23.0 means -23, 7e3 means 7000.0, and 4e~2 means 0.04
» unit is used to represent black (i.e., uncolored) tokens

» Reals are supported in ML but cannot be used as a color set
because equality is undefined and hence bindings cannot be
calculated
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Basic operators

~ for the unary minus

+and — for reals and integers

* (multiplication) for reals and integers

/ (division) for reals

div and mod for integers (28 div 10 = 2, 28 mod 10 =
8)

¢ =, > <, >= <=, <> for comparing things (note the
notation for >= (greater than), <= (smaller than), and
<> (not equal)).

A for strings (concatenation "AA"*"BB" ="AABB")
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Logical operators

not (for negation)
andalso (for logical AND)
orelse (for logical OR)

If then else (choice based on Boolean argument, the
then and else part should be of the same type)

» not(1=1) results in false
»(1=1) andalso not(0>1 orelse 2>3) results in true
»if "X"="X" then 3 else 4 results in 3
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Exercise: Give type and value of each

result

a) if (4>=4) then ("Hello" " " ~ "World") else " X"
b) if true then 20 div 8 else 20 mod 8

c) not(1=1 orelse 1=2)

d) not(1=1 andalso 1=2)

e) if ("Hello" ~ " " A "World" = "X") then 20 else 3
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Color set declarations

A color setis atype that is defined using a color set
declaration color ... = ... 1 e.qg.,

e color | =int;
e color S =string;
e color B =Dbool;
e color U =unit;
 Once declared, it may be used to type places.

* Newly defined types like I,5,B,U may be used in other
color set declarations.

1

"color" is shown as "colset" in CPN Tools, but one can type "color" _
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Creating subtypes using the "with"

clause

e color Age =int with 0..130;

e color Temp =int with ~30..40;

e color Alphabet = string with "a".."z";
e color YN = bool with (no,yes);

» color BlackToken = unit with null;




Creating new types using the "with"

clause

e color Human = with man | woman | child;
» color ThreeColors = with Green | Red | Yellow;




Creating new types using product,

record, and list constructors

* color Coordinates = product | * | * [;

e color HumanAge = product Human * Age;

* color CoordinatesR =record x:1 *y:I * z:1;

« color CD =record artists:S * title:S * noftracks:I;
* color Names =list S;

« color ListOfColors = list ThreeColors;




Possible values (colors)

« Coordinates: (1,2,3), (~4,66,0), ...
« HumanAge: (man,50), (child,3), ...

* CoordinatesR: {x=1, y=2, z=3}, {x=~4, y=66, z=0},
{y=2, x=1, z=3}, ...

« CD: {artists="Havenzangers", title="La La",
noftracks=10}, ...

« Names: ["John", "Liza", "Paul"], [ ], ...
* ListOfColors = [Green], [Red, Yellow], ...

Note the difference between products and records.
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Example

e color Driver = string;

e color Lap = int with 1..80;

e color TimeMS = int with 0..10000000;

e color LapTime = product Lap * TimeMS;

* color LapTimes =list LapTime;

« color DriverResults =record d:Driver *r:LapTimes;
« color Race = list DriverResults;




Example (2)

A possible color of type Race is:

[{d="Jos Verstappen",
r=[(1,31000),(2,33400),(3,32800)]},

{d="Michael Schumacher”,
r=[(1,32200),(2,31600),(3,30200),(4,29600)]},

{d="Rubens Barrichello",
r=[(1,34500),(2,32600),(3,37200),(4,42600)]}]
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Operations on lists and records

[ ] denotes the empty list

AN concatenates two lists, e.qg., [1,2,3]**[4,5]
evaluates to [1,2,3,4,5]

.. adds an element in front of a list, e.g., "a"::["b","c"]
evaluates to ["a","b","c"]

# extracts a field of arecord #x{x=1,y=2} evaluates to
1




Constants

* It is possible to define constants, e.qg.,
e val jv ="Jos Verstappen" : Driver,
« vallapl=1: Lap;
e val start =0 : Time;
e val seven =7 :int;




Example

* Determine the value of constant Monaco:
e val jv ="Jos Verstappen" : Driver,
e val rljos =(1,31000) : LapTime,
e val r2jos =(2,33400) : LapTime,
« val r3jos =(3,32800) : LapTime,
e val r123jos =((1,31000)::[(2,33400)D*"[(3,32800)] : LapTimes;
e val jos ={d=jv,r=r123jos}. DriverResults;

e val michael = {d="Michael Schumacher",
r=[(1,32200),(2,31600),

. (3,30200),(4,29600)]}:DriverResults;

« val rubens = {d="Rubens Barrichello",
r=[(1,34500),(2,32600),(3,37200), (4,42600)]}:DriverResults;

 val Monaco =jos :: ([michael]**[rubens]) : Race;
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Exercise

« Determine the value of the following constants:
 val el =rljos::[ ];
e val e2 = #d(michael);
e val e3 = (#r(Jos))""(#r(rubens));




So what?



We can now type and initialize places!

declarations | color Driver = string;

I
| color Lap = int with 1..80; |
| color Time = real with 0.0..1000.0; |
OO | color LapTime = product Lap * Time; |
| color LapTimes = list LapTime; |
color DriverResults = record d:Driver * r:Laptimes; |
I

I

I

| color Race = List DriverResults;
val Monaco = [{d="Jos Verstappen", r=[(1,31000),(2,33400),(3,32800)]},
| {d="Michael Schumacher", r=[(1,32200),(2,31600),(3,30200),(4,29600)]},

na:ne of | {d="Rubens Barrichello", r=[(1,34500),(2,32600),(3,37200),(4,42600)]}]
place L T e e, B
O
O
o race Moglaco
type of O
place O O °Race O

initial
marking



Multi-sets

« To initialize places with multiple tokens but also for
various other purposes we need multi-sets also
referred to as bags.

* In CPN multi-sets are denoted using the following
notation: x1 vl ++ x2'v2 ++ ... ++ Xn vn
where vl is a value and x1 the number of times this
element appears in the multi-set, etc.

« E.g.,4"Red" ++ 2 "Green" ++ 1 "Blue" is a multi-set
containing 7 elements
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Initialization expressions

-i ‘2 ++ 54

1 "John" ++ 5 "Sara"

O
o © ©

0p)
EI@I%
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Trick

* Multi-sets are implemented as lists, i.e., 4 "Red" ++
2 "Green" ++ 1 "Blue" can also be written as e.g.
["Red","Red","Red","Red","Green","Green",
"Blue"].

* This is useful when using list functions.

2 ++ 34

INT




Arc Inscriptions

« Arc inscriptions are used to define input-output
behavior.

« Arc inscriptions may use variables.
* Variables are typed and need to be declared

| color STR = string; | pl "Hello World"
| var s:STR,; |
-—————— - STR
S
t1
S
p2

STR




Example

; |
| color INT = int; | pl 12 ++2°3
!var X:INT: |
- INT
X
tl
X+2
p2

« Give final marking.
INT




Binding

* Given atransition t with variables x1, x2, ..., Xxn on its
Input and output arcs, a binding of t allocates a
concrete value to each of these variables. These values
should be of the corresponding type.

* A binding is enabled if there are tokens matching the
values of the arc inscriptions.

 If abinding is enabled, it can occur, i.e., the transition
fires while consuming and producing the
corresponding tokens.

 The pair (t1,<x1=v1,x2=v2, ...xn=vn>)is called a binding
element.

CPN-27




Example

 Two binding elements: (t1,<x=2>) and (t1,<x=3>)

| color INT = int; | pl 12++23
| var X INT; |
L - INT
X
t1l
X+2
p2

INT




Example

* Binding element (t1,<x=0>). After it occurred
(t1,<x=1>), etc.

’ |
| color INT = int; | pl 0)
| var X:INT; |
|

- INT

X xX+1
t1
X
P2

INT




Example
No binding
possible!

I color INT = int;

lvar X:INT; :

| var y:INT; Q

——————— —I

O O o °
pl 1 p2 2 p4 1 p5 2 p7 1 p8 2
INT INT INT INT INT INT
X X X y X y-X
tl t2 t3

X X+y °© y
p3 pé © po
INT INT O INT




Exercise

« Give all possible binding elements and final markings

pl 2 5++37

_______ T

INT
I X

| var X:INT;
| var y:INT;

INT INT




Exercise

« Give all possible binding elements and final markings

_______ p4 2 5++3°7
|color INT = int; ll @
| var X:INT; | INT
| var y:INT; | X
t2
If X <=6 if X >6
then 1 x then 1°x

else empty / X else empty




Exercise

« Give all possible binding elements and final markings

2 5++3°
p/
r— — — — — 7 71 /
| color INT = int; |
|var X:INT; | INT
jvar y:INT; | X
t3
2'x ++ 3'(x-5)

P8

INT




Exercise

« Give all possible binding elements and a final marking

pl "Hello" p2 "World"

| color STR = string; |
| var x:STR; |
| var y:STR; |
| color INT = int; |
| var Z:INT, |
| color S = list STR; |
|var S:S;

| color R =record a:STR * b:S; :




Exercise

« Give all possible binding elements and a final marking

| color STR = string; |
| var x:STR; | L
|var y:STR: | p5 3 "Hi"++2 "Ho
| color INT = int; |

| var z:INT; |

| color S = list STR; |
|var S:S;

| color R =record a:STR * b:S; :




Example: Voting

| color Party = with CDA | PVDA | VVD;

lvar x:Party; : t 2 CDA ++

' ’ vote . +
| color Count = int with 0..200000000: 3 PVDA

. . | 1°'VVD
| var y:Count; | Party
| color PC = product Party * Count; | «
.

give_vote
A
(X,y) (x,y+1)

votes 1°(CDA,Q) ++
® O @) (PVDAOD) ++
PC 1°(vVvD,0)
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ﬂEPN Tools {¥ersion 2.2.0 - September 2006} — |I:I|5|
= Tool box
= Help
:vﬂgtﬁfg.inn ‘ Sim [ Miew | Hier Style ‘
(o M| b [pp/m
Time: 0 MNew Page
» Options
» History -
¥ Declarations 2 CDA++
» Standard declarations 65 3 PVDA++
¥colset Party = with CDA | PVDA | WD, “ 1 WD
¥var x:Party;
¥ colset Count = int with 0..200000000;
¥yar y:Count;

2 CDA ++ 3" PVDA ++ 17WD
¥colset PC = product Party * Count;
» Monitors
MNew Fage
FParty

give vote

(x.l\}"'+1:|

(x.l"}"'}

1" (CDA,D)++1" (PVDA,0)++1" (\WD,0)

BE

1" (CDA,D)++
0 17 (PVDA,0)++
“ 1" (wWD,0)




Exercise: Bank

* Consider a simple banking system. There are 1000
accounts numbered from 1 to 1000. People can
deposit or withdraw money. Only amounts between 1
EURO and 5000 EURO can be deposited or
withdrawn. The account may have a negative
balance.

« Model this in terms of a CPN model.




Exercise: Article database - =

B

Consider a database system where authors can
submit articles. The articles are stored in such a way
that it is possible to get a sequential list of articles
per author. The list is ordered in such a way that the
oldest articles appear first.

Note that the system should support two actions:
submit articles (with name of author and article) and
get articles of a given author.

We assume that each article has a single author and
that only authors already registered in the database
can submit articles.

* Model this in terms of a CPN model.
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Exercise (2)

« Extend the CPN model such that each article can
have multiple authors, i.e., the article is stored once
for each author, and that there is an explicit action
to add authors to the database.




« A guard is a Boolean expression attached to a
transition. Only binding elements which evaluate to

true are enabled.

« Denoted by square brackets.

| color INT = Int;
| var x:INT;
| var y:INT;
| var z:INT;

guard
evaluates to
false for
binding
(t1,<x=1,

tl

p3
INT




Example

« Give all enabled binding elements and the final

marking
p4
INT
_______ 1 X
| color INT = int; |
| var x:INT; R [X>Y] [z=x+Y]
| var y:INT;
| var z:INT,; _! X+y Z

INT INT




Exercise

« Give all enabled binding elements and the final
marking

| color Person= str; |
color Text = str; |
color Mail = record p:Person * t.:Text; |
I

x | [#p(X)="John"] x| [#p(X)="Sue"]

inbox_John inbox_Sue

Malil Mail

CPN-44




Exercise

« Give all enabled binding elements and all possible
final marking

1 2++1°7++1°15

| color INT = int;
| var X:INT;

[X>5] [x<10]

INT INT




color Account = int with 1..1000;
color Balance = int;

| color Amount = int with 1..5000;
| color AB = product Account * Balance;

I

| AA
| color AA = product Account * Amount; | (a,)
lvar a:Account; | ’
lvar x:Amount; |
!l/ar y.Balance; |

deposit
(@y) (a,x+y)
withdraw : (a,x) (a,y-x) database
AA < (ay) AB

withdraw
« The CPN model assumes that an account could have
a negative balance. Change the model such that the
balance cannot become negative, i.e., do not accept
transactions which lead to a negative balance.
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Function declarations

color INT =int;

fun fac(x:INT) = if x>1 then x*fac(x-1) else 1;

fun fib(xX:INT) = if x<2 then 1 else fib(x-1) + fib(x-2);

color L = list INT;

fun sum(x:L) =if x=[ ] then 0 else hd(x)+sum(tl(x));

fun odd(x:L) = if x=[ ] then [ ] else hd(x)::(if tI(x)=[ ] then [ ]
else odd(tl(tl(x))));

« Calculate fac(fib(3)) and modify odd such that the odd
lines are returned in reversed order.
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Where to find standard functions?

* These sheets.
e cpntools.org, see for example

http://cpntools.org/documentation/concepts/colors/declarations/co

lorsets/list colour sets and
http://cpntools.org/documentation/concepts/colors/declarations/co

lorsets/colour set functions

 wWww.standardml.org, see for example

http://www.standardml.org/Basis/list.himI#LIST:SIG:SPEC for list

functions,
http://www.standardml.org/Basis/integer.html#INTEGER:SIG:SPEC

for integer functions,
http://www.standardml.org/Basis/string.html#STRING:SIG:SPEC

for string functions, etc.



http://cpntools.org/documentation/concepts/colors/declarations/colorsets/list_colour_sets�
http://cpntools.org/documentation/concepts/colors/declarations/colorsets/list_colour_sets�
http://cpntools.org/documentation/concepts/colors/declarations/colorsets/colour_set_functions�
http://cpntools.org/documentation/concepts/colors/declarations/colorsets/colour_set_functions�
http://www.standardml.org/Basis/list.html�
http://www.standardml.org/Basis/integer.html�
http://www.standardml.org/Basis/string.html�

Example

r—-——— - == — — — — — -1
color INT:int;

color Author = string;
| color Article = string;
color AL = list Article;
| color AAL = product Author * AL;
var xX:Author;
lvar y:AL;
| fun count(z:AL) = if z=[] then 0 else 1+tl(z)

how_many
X
Author : A (x,y) Oatabase

INT




Questions

* |Is it possible to have multiple arcs connecting a
place and a transitions?

* Is it possible to have multi-sets as arc inscriptions
on input arcs?

* Is it possible to use constants or other expressions
without variables as arc inscriptions?

* Is it possible to use records, lists, etc. with variables
(e.g., {a=x,b=y} and x::y) in arc inscriptions?




Example: Multiple arcs

lrcolor | = int; 1

color U = unit; |

Icolor L =list I; |

color R =record a:l * b:l; | |
lvar x:l: | . y ‘
lvar yiI; |

lvar zI; |

|var s:L; |

multiple arcs
are allowed




Example: Multi-sets and constants

[——————————— 1 ultisets on
. : constants are
Icolor | =int; | | input arcs are allowed
color U = unit; allowed
Icolor L=listI; |
color R =record a:l * b:l; |
Ivar X:l; |
| var y:l; |
lvar z:I; |
|var s:L; |




Example: Records

—— - - - —-———-———= 1
| color | = int; |
color U = unit; :
| et records with
color L = list I: variables as
IcoIorR:record a:l *b:l: T
lvar x| arc inscription
lvar yI; |
|var z:I: |




Example: Lists

lrcolor | = int; 1|
color U = unit;

Icolor L=1listl; | I

| color R =record a:l * b:l; |

lvar x:I: | y
lvar yiI; |

lvar z:I: |

|var s:L: |
____________ o

lists with
variables as arc
inscriptions




Requirement

lrcolor | =int; 1|
color U = unit;

| colorL =list I |
color R =record a:l * b:l; |
Ivar x:I; |
lvar y:1; |
|var z:I; |
| var s:L; |

Z is unbound!

-0
20
0

Z is unbound!

‘s
U
U




Trick: use lists on arcs to

HEPN Tools (¥ersion 2.2.0 - September 2006)
»Tool box
Help Binder 0
Optio MNew Page
New net

produce/consume multi-sets of tokens

Sim Miew Hie

by

=10l

rations
»colse 1 * 1 ++
»colset INT )
» colset BOOL [11213-"4] 2_) 1‘2 \
» colset STRING
¥colset LINT = list INT;
Tvar i:INT;
a

unpack takes
one list token
and produces
a multiset of
tokens




Another example

Tool box
> Help Sim Wiew
» Options
¥ listbindings.cpn «|.|’0| N | k |kk[jm
Step: 0
Time: 0
» Options SoERs
w History Bl

¥ Declarations
¥ Standard declarations

wcolset UNIT 2° []++
» colset INT e "

» colset BOOL 6_/ 2 . [ LO_HElY ]++

¥colset STRING = string; 2 [" Mike "," Pete” ,"JOh n" ]

¥ colset Player = string;
¥colset Team = list Player;
wyar p: Player;
¥var t,s:Team;
¥ Monitors
main

¥ colset Player = string;
¥ colset Team = list Player;
¥var p: Player;
¥vart,s: Team;

2 ["Mike"," Pete”,"John" ]++2 []++2  ["Lonely”]

>

unpack

pack

Player
P
movel
P
P
Player

5E 57




Priority (no priority P_NORMAL = 1000)

| i CPN Tools (Version 3, =1

+Tool box

k- Help ' ; ;
» Options Binder 0 |m View
¥ no-priority.con no-prio .-“-. =8 %
Step: 0
Time: 0 +Tool box
= Options 2 HE'F‘ ! ‘ Sim Wiew l
» History h-Dptn:u_ns_ Binder 0
¥ Dedarations ¥ no-priority.cpn no-prio «|.|’O| N | k |MJ”
¥ Standard prioritias S_tep: =il
vval P_HIGH = 100; Jiaizs
¥val P_NORMAL = 1000; *Options
vval P_LOW = 10000; gz
¥ Standard declarations L azs L
» colset UNIT ¥ Standard prioritias 50° (]
» colset INT ¥val P_HIGH = 100;
v colset BOOL ¥val P_NORMAL = 1000; o UNIT
» colset STRING vl LI = 0000
» Monitars ¥ Standard declarations 4]
g # colset LIMIT
w colset INT 0
# colset BOOL
# colset STRING 1 t2
= Maonitors
no-prio
0 ()
p2 16 16°() ps 134 34°()

. T

LUNIT LINIT




IAVACEE)

+Tool box
»Help

7 CPN Tools Version 303 Tancary 267 7 .- o v

» Options |m View
¥ same-priarity.con { 45 CPN Tools (Version 3.
Step: 0
Time: 0 Binder 0 || > Teol box
» Options same-prig el Sim  View
= History "Opt“:'r's. .
¥ Declarations AR 2T «|.|’O| N | k |thll.l
¥ Standard prioritias S_tep: =il -
vval P_HIGH = 100; Uy (2 SRR
vval P_NORMAL = 1000; 212 same-hrs
vval P_LOW = 10000; Plallgel)
¥ Standard declarations ¥ Dedlarations o
» colset UNIT **higher numl ¥ Standard priorities »
F colset INT is lower priorit ¥ val P_HIGH = 100; .
» colost BOOL ¥val P_NORMAL = 1000; 50°()
» colset STRING ¥val P_LOW = 10000;
» Monitors ¥ Standard declarations .
same-prio = colset LINIT .‘"*h|gher n.umber
b colset INT is lower priority®*

= colset BOOL

= colset STRING
= Monitors
same-prio




Priority (P_HIGH wins)

& CPN Tools (Version 3. =

wTool box ‘
»Help . .
» Opticns Sim  Wiew
¥ different-priority.con I~ —
Step: 0  CPN Tools (Mersion
Tirn;: 0 Binder 0 +Tool box
» Options different-prio » Help Sim  Viaw
- History » Options
¥ Declarations ¥ different-priority .cpn « . ’O N k ”Jm
¥ Standard prioritias S_tep: 50
¥val P_HIGH = 100; Time: 0 Binder O
¥val P_NORMAL = 1000; » Options different-prio
¥val P_LOW = 10000; = History
¥ Standard declarations ¥Decdarations
w colset UNIT ¥ Standard prioritias i
w colset INT ¥val P_HIGH = 100; 50°()
» colset BOOL ¥val P_NORMAL = 1000; o i
F colset STRING ‘ Tval P_LOW = 10000;
= Monitors ¥ Standard declarations 0
different-pric # colset LIMIT
P_HIGH b colset INT ]

= colset BOOL
k= colset STRING

= Monitors
q different-prio P HIGH = Lai




Priority: Guess final state

“g» CPM Tools (Version 3.0.2, January 2011) 5

eTool box
= Help
- Options
¥ mixed-priority.con
Step: O
Time: 0
= Options
= Histary
¥Declarations
¥ Standard pricrities
¥val P_HIGH = 100;

¥val P_NORMAL = 1000;

¥val P_LOW = 10000;
¥ Standard declarations
e colset UNIT
colset INT
+colset BOOL
colset STRIMNG
= Monitors
different-pric

‘ Sim  Wiew

(D[ M [ b phimu

Binder 0
different-prio




Result

“g CPN Teols (Version 3.0.2, January 2011) EE
»Tool box

»Help : .
» Options Sim Wiew
¥ mixed-priority.cpn

Timo: 0 C(HDolN b

Binder 0
» Opticns different-pric
- History
¥ Deaclarations
¥ Standard pricrities
¥yval P_HIGH = 100;
¥val P_NORMAL = 1000;
vval P_LOW = 10000:;
¥ Standard declarations
e colset UMIT
e colset INT
Fcolset BOOL

e colset STRIMNG
= Monitors

different-prio




Global property (t2 never fires)

“g CPN Teols (Version 3.0.2, January 2011)

eTool box
el ‘ Sim  Wiew

Do M| b b

» Options
¥ global-priority.cpn
Step: O
Time: 0 Binder 0
» Opticns different-prio
- History
¥ Deaclarations
¥ Standard pricrities
¥yval P_HIGH = 100;
¥val P_NORMAL = 1000;
vval P_LOW = 10000:;
¥ Standard declarations
e colset UMIT
e colset INT
Fcolset BOOL
= colset STRING
= Monitors
different-prio




Time in CPN

* Tokens are either untimed (are always available) or
timed (bear a timestamp).

* Color sets can be made timed color sets by adding
the keyword timed.

A delay iIs modeled by v@+d as arc expression on an
outgoing arc where v is the value and d is the delay
of the produced token.

* Delays may depend on the values of tokens to be
consumed (i.e., through the binding of variables).

CPN-64




- — — — STR INT
color STR = string timed, X y
var X:STR;
color INT =int; t1
var y:INT;
- — — — —  x@+1 X@+y
p3 p4

STR STR




Exercise

« Determine a possible final state.

p5 2‘IIHi||++2‘IIHOI|
color STR = string timed,; STR
var x.STR; X
color INT = int;
var y:INT,; t2
|
v/ /y+1 @+

pPo6

INT




Time (t1 Is enabled at time 2)

“go CPN Tools (Version 3.
»Tool box | )
* HE'F‘ Binder O Sim  \iew
= Options no-prio
vtimel.cpn k kk NL!
Step: O 0
Time: 2
+ Options
= History _ 5 1 (J@3+++
¥ Declarations 1 (@2
» Standard priorities 1 1" (@1 1 @2 ++ 1 1 ()@4|
¥ Standard declarations @1 1 (@3 @4

¥ colset UNIT = unit timed;
b colset INT e e
» colset BOOL UNIT

Uf‘-.IIT
= colset STRING 0 UNIT
= Monitors
no-prio () ()
tl 2
(J@+2 (J@+3




tl fired at time 2; t2 Is enabled at time 4

‘g CPN Tools (Version 3.

= Tool box
»Help
+ Options
¥omel.con
Step: 1
Time: 4
» Options
B History
¥ Declarations
» Standard priorities
¥ Standard declarations
¥ colset UNIT = unit timed;
# colset INT
 colset BOOL
» colset STRING
» Monitors
no-prio

Binder 0
No-prio

. _ I
Sim - AWiew
<(Mpo| b | [pp)m:
1 1 (@3
1 ()@2 ++ 1 17 ()@4|
(@1 1" (J@3 (@4
OO O
LINIT UNIT
() ()
() ()
t1 t2
(J@+2 (J@+3
LINIT NIT
1 1 (@4




“Real” time

“g2 CPN Tools (Version 3.
wTool box | ]
wHelp Binder 0 - -
» Options pep— Sim Wiew
(oM | ppjmu
Step: 1 ‘ "O‘
Timea: 4
¥ Options
COutput ry : <same as maoi i1 @z
EReal Timestamp L :
» Performance report statistics 1" (@2 ++ 1 1'()@4|
» Histary (@1 1 (@3 @4
¥Declarations
» Standard prioritias UNIT
¥ Standard declarations LINIT UNIT
Tcolset UNIT = unit timed,; 0 0
w colset INT 0 0

e colset BOOL

= colset STRING
» Maonitors t1 £2
no-prio
(J@+2 (J@+3
LIMNIT H LMIT

Plzase save the ﬂét, close it and reopen it for the i:ﬁ-aﬂge to take effect

J ]




Note the types and the @++

S CPN Tools (Version 3.0.2, January 2011)

B Tool I:nmé

> Help Binder O : :
» Options no-prio Sim Miew

ranezaon o/ M| b [pp/mu

Time:

i 3

irectory : <same as maoi 5 1: H@H.D+++
ElReal Timestamp - -1 (j@m2.0
» Performance report statistics 1 1 ()J@1.0 1" 0@2.0 44 1 1 ()@4.0
» History (J@1.0 1°()@3.0 (J@4.0

¥ Declarations
- Standard pricrities e UNIT
¥ Standard declarations LIMIT
¥colset UNIT = unit timed; 0 0
B colset INT
» colset BOOL () ()
b colset STRING
» Monitors t1 2
no-pric

(J@++2.0 (1@++3.0

LINIT LMIT




Determine final state

“g» CPM Teols (Version 3.0.2, January 2011)

Tool box | i
» Help Binder O - -
» Options no-prio Sim  MiEW
vtime3.con «‘.‘m‘ M ‘ > ‘h&l""

Step: O

Time: 0.0

¥ Options
Output directory : <same as mao 1 []@D.D|

EReal Timestamp

» Performance report statistics ()
k- History
¥ Declarations UNIT

r Standard priorities

¥ Standard declarations (J@+50
¥ colset UNIT = unit timed; 100 100° a.n
» colset INT 1% 0
#colset BOOL 0 3.0
» colset STRING o t1 £2 il o
= Monitors UNIT UNIT

no-prio




Final state (time = 10000)

Tools (Version 3.0.2, January 2011)

J0X

i 1
Wiew

«m oy | b o

1 1 ()@10000.0|

Binder O
ns no-pric
Ma{ulyl
o 200
e 10000.0
fions
Iutput directory @ <same as mao

eal Timestamp

erformance report statistics ()
Cory
larations LINIT

tandard priorities

tandard declarations

Foolset UNIT = unit timed; 0
- colset INT 100° ()

- colset BOOL o 0

- colset STRIMNG
LINIT

(J@+50

£l

nitors
Fric

(J@++3.0 .
LIp

100

(J@+50

I e e e e e S e e e Y e e e e = = S =

r

T(J@9953.04+++
T(I@9B53.04+++
(I@O7E3.04+++
I@9s53.04+++
(I@9553.0+4++
(1@O453.0+++
(I@9353.04+++
T(I@O253.04+++
TI@2153.04+++
()@053.04+++
I@B953.04+++
(I@EBESI.0+++
(I@B7S3.0+++
(I@EE53.0+++
(I@BSS3.04+++
(I@E453.04+++
(J@B3S3.04+++
()@B253.0+++
I@E153.0+4++
(I@B0S3.0+++
I@7953.04+++
(J@TES2.04+++
(@775 I0+4++

-




Overview of CPN (with color and time)

initialization
expression

declarations

I- .
|color INT = int;

[x<n] "Token"

I
color STR = string timed;' | . .
’ 1 12++2°3 2
var X:INT; | P - ya@+2 P
Ivar y:STR; | _
Ival n=4INT | INT Incr(x) t1 Y sTR
Iiun incr(z:INT) =z+1; |

transition
name

variable

function
declaration

place type arc inscription



Coffee and tea example (1)

* We need to produce 100 cups of tea
and 100 cups of coffee.

* There are two persons able to

manufacture these drinks: Adam and
Eve.

« Assume "random allocation". Eve | Adam
 Production times:

tea 2 6

coffee 12 4




Coffee and tea example (2)

« Simulate the model a couple of
times and record the makespan.

« Evaluate two control strategies:

 Eve just makes tea and Adam just
makes coffee.

« Adam makes coffee and Eve can make
both.

e Eve makes tea and Adam can make
both.

 Why is it diffcult to model
priorities/preferences?

Eve

Adam

tea

coffee

12




EEPN Tools (¥ersion 2.2.0 - September 2006)
pTool box
»Help

» Options
¥ctl.cpn

Sim | View | Hier

Do/ M | b b

Style

Step: 400
Time: 620
» Options
+ Histary
¥Declarations
» Standard declarations
¥colset Prod = string timat
» colset Res
» colset PR
W varp
W varr
rfun delay(p,r) =
if p="tea"
then
if r="Eva" then 2 else &
else
if r = "Eve"then 12 else 4
» Monitors

Main 100" "coffee”++100° "tea" r

P P

Prod (p.rl

Binder 0
Main | fun delay

1" "adam" @E12+++
2 1 "Eve'"®620

1" "Eve"++1" "Adam"

free

Res

(p,r)@+delay(p,r)
in production
PR

None

N e e = e e el el = 15 IS ST 6 S 6 I

Fs

Tcoffee"@G20+++
"coffee"@E124+++
"coffee"@B0B+++
"coffee"@E04+++
Tcoffee"@S94+++
Tcoffee"@STE+++
"coffee" @S TE+++
Tcoffee"@ST4+++
"coffee"@SE4+++

"coffee"@S52+++

Tcoffee" @S 48+++
"coffes" @S 3IB+++
"coffee"@S32+++
"coffee"@S24+++
Tcoffee"@S12+++
Tcoffee"@S10+++
" coffee" @506 +++
T coffee"@S00+++
"coffee”" @488 +++
Tcoffee"@484+++
"coffee" @480+++
"coffee”" @47 4+++
Tcoffee"@470+++

.

eady @ +/- 620




Eve just makes tea and Adam just makes coffee.

ﬁEPN Tools (Yersion 2.2.0 - September 2006}
w Tool box

» Help Sim  Wiew | Hier 'Style
= Options

(Epo M » o

Tirme: 400 _
» Opltions Binder 0
» History Main [fun delay

¥Declarations
» Standard declarations
¥colset Prod = string timed;

» colset Res
»colset PR
Fyvarp »
SUEE [ o 1: ::Ada:n"o@400+++
¥fun delay(p,r) = 1" "Eve" @200

if p="tea 1" "Eve'++1" "Adam”

then

if r="Eve" then 2 alse & free

else o

T : oF

if r = "Eve"then 12 else 4; =" Emlsn —"Er =) Erslse .

g MD_nltDrs (p="coffee" andalso r="adam"]]
Main F
100" "coffee"++100" "tea"
p p
to produce start prod end prod ready (200
Prod (p,r) Prod
(p,r)@+delay(p,r)
in production
PR

Ready @ 400

None




Adam makes coffee and Eve can make both

EEPN Tools (Yersion 2.2.0 - September 2006)
wTool box
» Healp Sim  ‘iew Hier Style

» Options
C(Epo| M | b o
Step: 400
Time: 416 _
» Options Binder 0
» Histary Main | fun delay

¥ Declarations
w Standard declarations
¥colset Prod = string timed;
= colset Res
= colset PR
svarp
o UEE P 1" "Adam" @328 +++
wfun delay(p,r) = 2/ 1" "Eve"@416
if p="tea" 1" "Eve"++1 "Adam"
then
if r="Eve" then 2 else & free
alse
if r="Eva"thaen 12 alsa 4;
» Monitors

Res
[(r="Eva") orelse

[p="coffee" andalsc r="&dam")]

Main

0" "coffee”++100" "tea"

p /’“_‘\

Prod (p,r) Fro

(pri@+delay(p,r)
in production
PR

Ready @ +/- 416

Nane




Eve makes tea and Adam can make both

EEPN Tools {¥ersion 2.2.0 - September Z006)
+Tool box

»Halp Sim  Wiew | Hier Style
» Options

redean CEpo| M| ppjm:

Time: 460 :
» Options Binder 0
» History Main [ fun delay

¥Declarations
» Standard declarations
¥colset Prod = string timed;

w colset Res
wcolset PR
wvarp
B varr = 1" "Adam"@460+++
¥fun delay(p,r) = 1" "Eve"@1B0
I p="5a 1" "Eve"++1 "Adam”
then
if r="Eva"then 2 elsa & fraa
else :
PR . o
if r = "Eve"then 12 alse 4; [(p="tea" andalso r="Eve") .
hMD_ﬂItDrS oralse (r="Adam"}]
Main =
0" "coffee"++100" "tea"”
P P
to produce start prod end prod ready (20
Prod (p,r) Prao

(p,r)@+delay(p,r)
in production
PR

Ready @ +/- 460

Mone




A smarter strategy

* Eve just makes tea and Adam just makes coffee
unless ...
e Eve can make coffee if there are no tea orders left.

« Adam can make tea if there are no coffee orders left.

 Why Is It diffcult to model
priorities/preferences?

 Let us look at an intermediate solution
using counters rather than lists.




CPN model with counters

“EPN Tools (¥ersion 2.2.0 - September 2006}
»Tool box

»Help
» Options
¥ct2d.cpn
Step: 0
Time: 0
» Options
» History
¥ Dedarations
»Standard declarations
¥ colset Prod = string timed;

Sim  \iew | Hier Style ‘

(o[ M| oy

Binder 0
Main | fun delay

i1 100|
» colset Res T
»colset PR
Evarp -1
wvarr

[(i>0) andalso ((j=0) orelse (r="Eve")) ]
100

wvarijiINT;
¥fun delayip,r) =
if p="tea"
then
if r="Eve" then 2 alse &
alse
if r = "Eve"then 12 else 4;
»Monitars
Main

start prod tea

ot

("tea",r)@+delay("tea”,r)

PR

("coffee" ,r)@+delay("coffee",r)

. ™

1°"Adam" @O +++
2 1 "Eve"@o0

I [=les|

1" "Eve"++1 "Adam”

Res
r

La

end prod

start prod coffee

< J

[(j>0) andalso ((i=0) orelse (r="Adam")) ]

Prod




Almost optimal makespan ...

il cPN Tools (Version 2.2.0 - September 2006) =13l ]
Tool b
:HZ\DD o Sim  Wiew Hier Style ‘
» Options
¥ ct2d.cpn Binder 0 «|.|’0| H | k |kkl:|nu
?ten: gg: Main [fun delay =
ima:
R . " "coffee” @356 +++4
S o ﬂ » 1 "Adam" @348 +++ “"coffee” @348 +++
» Standard declarations -1 [(i>0) andalso ((j=0) orelse (r="Eve")) ] 2 1 "Eve"@356 ""coffee” @344 +++
¥ colset Prod = string timed; 100 “"coffee" @340 +++4
e 1'"Eve"++1""Adam’ " "coffee” @336 +++
" "coffee” @332
Sl start prod tea |4 . Qe 5 -ngr::- gBZS::j
T L INT; “w "
v;jr: ‘dje\ay"(p,r) = Res coffee” @324 ++4

if p="tea

then

if r="Eve" then 2 else &
else

("tea”,r)@+delay("tea”,r) r “"coffee” @320 +++

“"coffee” @316 +++4

if r="Eve"then 12 else 4; : “coffee” @3 12444

» Monitors p "coffee” @308 +++
Main in production  end prod ready 209/ “"coffee” @304 +++4
" "coffee” @300 +++4

PR Prod ""coffee” @296 +++4

" "coffee" @292 +++4
""coffee” @288 +++4
“"coffee” @284 +++4
""coffee” @280 +++4
“"coffee” @276 +++4
""coffee” @272 ++4
" "coffee” @268 +++4
""coffee” @264 +++4

("coffee” ,r)@+delay("coffee”,r)

make coffee start prod coffee | =

PRNHERERNERNEBPRNRRERENRERRNR RN

[(j>0) andalso ((i=0) orelse (r="Adam")) ]

Ready @ 356

MNone

Adam: 87 coffee

Eve: 100 tea and 13 coffee Optimal
Makespan = 356 Adam: 88 coffee

Eve: 100 tea and 12 coffee
Makespan = 352
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¥ Declarations

» Standard declarations

¥ colset JobID = int timed;
M/G/l q u eu e ¥ colset Timestamp = int;
¥ colset Job = product JobID*Timestamp timed;
¥ colset JobList = list Job;
¥ colset Res = unit;
¥yar 1:1oblID;
¥yvar riFes;
¥vyar |:JobList;
¥yvar b Timestamp;
¥fun iat() = round({exponential(0.05));
¥fun ptl) = round{normal{10.0,1.0));
¥fun Mbime() = IntInf.tolnt{timeal()):int;

910
()

I~ [(5,Mtime ())]

. ]
1,1 1@0 [i<=1000]

f) L0

JoblList

ot
end proc

Job

j+1@+iat() (1,t)@+pt()

Poisson arrival process (expected average interarrival time is 1/0.05=20).

Expected service time is 10 (Normal distribution) _




To measure results: CPN monitors




Create monitors

"™ CPN Tools (Version 2.2.0 - mber n=l
w»Tool box
»Help g ityle Treate Nel Mon fiaw
= Options Data | Mark | Break | User | Write
¥mmil-test.con Binder 0 Call | Si paint | def | in file
Step: 0 example functions mml
Time: 0 LL
= Options i
» Histary

¥Declarations
» Standard declarations
¥ colset JobID = int timed;
¥ colset Timestamp = int;
¥ colset Job = product JobID*Tim
¥ colset JobList = list Job;
¥ colset Res = unit;
¥var j:JoblD;
¥yarrRes;
¥var [:JobList;
Tvar t.Timestamp;
¥fun iat() = round(exponential(0
¥fun pt() = round(normal(10.0,1
wfun Mtime() = IntInf.toInt(time( 3 [~ [(,Mtime( )

]
¥var resulttINT; 1" 1@0 X
*Monitars 7 & [i<=1000]

¥Marking_size_mm1'free_1 1

»Type: Marking size

»Nodes ordered by pages start oeate measure
¥Marking_size_mm1'busy_1

»Type: Marking size
» Nodes ordered by pages JobID
¥List_length_dc_mm1'gueue_1

)17 [] r r
\
start proc end proc
JobList
(.D@+p G0

= Type: List length data collect X . t(]
» Nodes ordared by pagas j+i@+iat()
rflowtime
» Type: Data collection
» Nodes ordered by pages Job
» Predicate
¥ Observer
fun obs (bindelem) =
let

fun obsBindElem (mm1'me
| obsBindElem _ = ~1
in
obsBindElem bindelem
end
» Init function
» Stop
example functions
mm1l None




"N CPN Tools (Version 2.2.0 - mber
- — @@ - =

= Tool box
- Help
= Options
¥ mml-test.cpn
Step: O
Time: 0
» Options
» History
¥Declarations
» Standard declarations
¥colset JobID = int timed;
¥ colset Timestamp = int;
¥colset Job = product JobID* Timestamp timed;
¥ colset JobList = list Job;
¥ colset Res = unit;
¥var j:1obID;
¥var r:Res;
¥yar [Joblist;
Tvar t:Timastamp;
¥fun iat() = round(exponential(0.05));
¥fun pt{) = round(normal(10.0,1.0});
rfun Mtime() = IntInf.tolnt(time()):int;
¥yar result: INT;
¥ Monitars
¥Marking_size_mm1'free_1
»Type: Marking size
» Nodes ardered by pages
¥ Marking_size_mm1l'busy_1
FType: Marking size
» Nodes ordered by pages
¥List_length_dc_mm1l'gueue_1
»Type: List length data collection
» Nodes ordered by pages
¥flowtime
»Type: Data collection
» Nodes ardered by pages
» Predicate
¥Observer
fun obs (bindelem) =
let

fun obsBindElem (mm1'measure (1, {1.t}]) = Mtime() -

| obsBindElem _ = ~1
in
obsBindElem bindelem
end
- Init function
» Stop
axample functions
mml

T ARttty

¥ Maonitors
¥Marking_size_mm1l'free_1
»Type: Marking size
» Nodes ordered by pages
¥Marking_size_mml'busy_1
»Type: Marking size
»MNodes ordered by pages
¥List_length_dc_mml'queues_1
= Type: List length data collection
» Nodes ordered by pages
¥flowtime
e Type: Data collection
»MNodes ordered by pages
» Predicate
¥ Observer

fun obs (bindelem) =
let
fun cbsBindElem (mml'measure (1, {3,£3)) = Mbime() - £
| obsBindElem _ = ~1

Sirr Style Create lef Mar View

Q Q%% &

Binder 0

example functions  mm1 |r|
obsBindElem bindelem
end
# Init function
e Stop
110
8]
. j I~~[(jMtime()]] (3,601 @ Res
1)1 100 [i<=1000] r r
1
@ - (1.t @ (it
start create start proc end proc measure
Job
JabID JobList -
' i
j+1@+iat() UB)@-+pt()

Job




-l

¥ Maonitors
¥Marking_size_mmlfree 1
¥Type: Marking size
O Logging
» MNodes ordered by pages
¥Marking_size_mml'busy_1
¥ Type: Marking size
oOLogging
»MNodes ordered by pages
¥List length_dc_mml'gueus_1
¥ Type: List length data collection
O Logging
» MNodes ordered by pages
¥ flowtime
¥Type: Data collection
oTimed
O Logging
= Modes ordered by pages
» Predicate
¥ Observer

fun obs (bindelem) =
let
fun obsBindElem (mml'measure (1, {],t})) = Mome() -t
| obsBindElem = ~1

I

obsBindElem bindelem _
and




One run

7€ CPN Tools Simulation Perfc NIRRT
€ CPN Tools Simulation Pe
1 3 2 g, D:\courses\BIS-2010NCPMY coffee-and-tea\outpu H|

x ﬁComert + [P0 Select

>

.7 Favorites | 75 @] TU-e- StudyWeb (2] & TU-e - StudyWeb g Keep Alive @ nu.nl Het laatste nieuws ...

|@CPNTooIsSimulation Performance Report ‘ | - v [ p=1 v Page~ Safety= Tools~v (@~ ¥

Fs

CPN Tools Simulation Performance Report
Net: Dicourses'BIS-20100CP N \coffee-and-tea'mm] -test cpn

Note that these statistics have been calculated for data that is not necessarily independent or identically distributed.

| Timed statistics

| Name ‘CDII]II‘ Avrg |Il1i|1|1\-lax
List length_dc_mm!'quene_1 2002 03192760 |6
\Marking_size_mml'busy 1 2002 0.508891(0 |1
\Marking size mml'frec 1 2002 |0.491109(0 |1

| Untimed statistics
|Name |CDII]11‘ Sum ‘ Avrg ‘Lﬁu‘hlax
fowtime | 1000 16300 16.300000 7 |71

Simulation steps executed: 4000
Model time: 19682

Generated: Mon Mar 15 20:51:11 2010

Done M Computer | Protected Mode: Off




Multiple subruns

"™ CPN Tools (Version 2.2.0 -

w Tool box
» Help Sim | Style 'Create Net Mon \iew
» Options
¥mm1l-test.con
Step: O
28 @ Binder 0
» Options example functions  mmi
» History
¥Declarations
w Standard declarations
¥colset JobID = int timed;
¥ colset Timestamp = int;}
¥colset Job = product JobID* Timestamp time
¥colset JobList = list Job;
¥colset Res = unit;
¥var j:lobID;
¥yarriRes;
¥var |:Joblist;
¥var t.Timestamp; 1.1°0)
¥fun iat() = round(exponential(0.05));
¥fun pt() = round(normal{10.0,1.0));
¥fun Mtime() = IntInf.tolnt{time()):int; i [~ [ MEme()]

¥var rasult:INT; 5
¥ Maonitors 1_.-‘ 1w [j<=1000]

¥Marking_size_mm1'free_1 1
¥Type: Marking size
olLogging start create
»Modes ordered by pages
¥Marking_size_mm1'busy_1 JabID
¥Type: Marking size
OLogging j+1@+iat()
»MNodes ordered by pages
¥List_length_dc_mml'queus_1
¥Type: List length data collection Job
oLogging
»MNodes ordered by pages Clone
¥flowtime Aux
¥Type: Data collection Evaluate
oTimed ML
OLogging CPN'Replications.
»MNodes ordered by pages
»Predicate
¥Observer
fun obs (bindelem) =
let

o e N' Rep | I C atl ons.n r9p | | C atl ons 10

start proc end proc

(i.t) @ 0.t)
measure

Job

Joblist

(it)@-+pt() (it)

Delete
AU

obsBindElern bindelem
end
» [nit functian MNone




Results with confidence intervals

& CPN Tocls Performance

el &) Di\courses\BIS-2010\CPN\coffee-and-tealoutputireps 2\PerfReportl ~ |43 | x [

x ﬁComeﬂ - [0 Select

{‘? Favorites | 1;3 &] TU-e - StudyWeb (2) @& | TU-e - StudyWeb o Keep Alive @ nu.nl Het laatste nieuws ... Wetter Schleiden - Wetter...

|§CPNTooIsPerformancaReport | | - v [ g v Pagev Safetyv Toolsv @~ *

-

CPN Tools Performance Report ]
Net: D-\courses' BIS-20100CPN \coffee-and-tea'mm] -test.cpn
Number of replications: 10

| Statistics
| Name | Avrg  [90% Half Length |95% Half Length |99% Half Length  StD | Min | Max
List_length_dc_mm]'queune_1

| count_id [2002.000000 [0.000000 |0.000000 |0.000000 0.000000 2002 2002
|max id [6.100000  [1.204686 [1.597607 2203542 2233582 |5 12
|min_iid [0.000000  [0.000000 |0.000000 |0.000000 10.000000 [0 o
|avg_id 0254992 [0.020017 0.024702 |0.035492 0034534 0202483 [0.303056

Marking_size_mm]'busy_1

| count_iid |2002.000000 [0.000000 |0.000000 |0.000000 [0.000000  |2002 [2002

|max dd [1.000000  [0.000000 |0.000000 |0.000000 10.000000 |1 [1 i
|min_iid [0.000000  [0.000000 |0.000000 |0.000000 10.000000 [0 o 1
|avg_id [0495445  [0.006449 0.007938 [0.011434 0011125 0472663 |0.510056

Marking_size mml'free_1

| count iid [2002.000000 [0.000000 |0.000000 |0.000000 10000000 [2002  |2002
|max dd [1.000000  [0.000000 |0.000000 |0.000000 10.000000 |1 [1
|min_id [0.000000 [0.000000 |0.000000 |0.000000 10.000000 [0 o
|avg_id [0.504355  [0.006449 |0.007938 [0.011434 0011125 [0.489944 (0527337
| flowtime

|count iid [1000.000000 |0.000000 |0.000000 |0.000000 10000000 [1000  [1000
|max_id [65.700000  [12.670113 [15.635459 [22.464739 21.858383 |48 119
|min_iid [6.600000  [0.405292 0500147 0718602 0699206 |5 |7
|sum_sid [15131.000000 [373.615684 |461.057652 |662.439155 644.558936 [ 14055 |16106
laves 4 [15.131000  [0.373616 [o.461038 |0.662439 0644559 | 14.055000 |16.106000
i mwrmin A A e W 18 WAEDT NN v

Done M Computer | Protected Mode: Off Ya v H100% -




K E=EET)
- 5
s

£ DA\courses\BIS-2010\CPN\coffee-and-tea\outputireps 2\PerfReportl v | 44 | X || *f Google P~

X ﬁﬂumert ~ %0 Select

>

¢ Favorites | 95 @] TU-e- StudyWeb (2) @& TU-e- StudyWeb (g Keep Alive @ nu.nl Het laatste nieuws ... E Wetter 5chleiden - Wetter...

o v [ mm v Pagev Safetyv Tools~ i@~ >
CPN Tools Pefformance Report B
Net: Di\courses'BIS-20100WCPN'\coffee-and-tea'mm] -test.cpn
Number of replications: 10

| g CPM Tools Performance Report | |

Statistics
Name Avrg 90% Half Length 95% Half Length 99% Half Length StD Min Max
List_length_dc_mm]'quene_1

count_iid | 2002.000000 |0.000000 0.000000 0.000000 0.000000 |2002 2002

max_iid |6.100000 1.294686 1.597697 2.2955412 2233582 |5 12

min_iid | 0.000000 0.000000 0.000000 0.000000 0.000000 |0 0

avrg_iid |0.254992 0.020017 0.024702 0.035492 0.034534 |0.202483 |0.3030356
Marking size mml'busy 1

count_iid | 2002.000000 |0.000000 0.000000 0.000000 0.000000  |2002 2002

max_iid | 1.000000 0.000000 0.000000 0.000000 0.000000 |1 1 1

min_iid | 0.000000 0.000000 0.000000 0.000000 0.000000 |0 0 )

avrg id |0.495445 0.006449 0.007958 0.011434 0011125 |0.472663 |0.510036
Marking_size mml'free 1




max_iid |6.100000 1.294686 1.597697 2.2955412 2233582 |5 12

min_id | 0.000000 0.000000 0.000000 0.000000 0.000000 |0 0

avrg_iid |0.254992 0.020017 0.024702 0.035492 0.034534 |0.202483 |0.303056

Marking_size_mml1'busy_1

count_iid | 2002.000000 |0.000000 0.000000 0.000000 0.000000  |2002 2002

max_iid | 1.000000 0.000000 0.000000 0.000000 0.000000 |1 1 1

min_iid | 0.000000 0.000000 0.000000 0.000000 0.000000 |0 0 )

avrg iid |0.495445 0.006449 0.007958 0.011434 0.011125 |0.472663 |0.510056

Marking size mml'free 1

count_iid | 2002.000000 |0.000000 0.000000 0.000000 0.000000 |2002 2002

max_iid |1.000000 0.000000 0.000000 0.000000 0.000000 |1 1

min_iid | 0.000000 0.000000 0.000000 0.000000 0.000000 |0 0

avrg_iid |0.504555 0.006449 0.007958 0011434 0011125 |0.489944 |0.527337

flowtime

count_iid | 1000.000000 |0.000000 0.000000 0.000000 0.000000  |[1000 1000

max_iid |65 700000 12670113 15.635459 22464739 21 858383 |48 119

min_iid | 6.600000 0405292 0.500147 0.718602 0699206 |5 7

sum_iid | 15131.000000 373.615684 461.057652 662.439155 644.558936 | 14055 16106

avrg id |15.131000 0373616 0461058 0.662439 0.644559  |14.055000 |16.106000
mmmntnde Afme M 18 IN-E.97 NN x

Done M Computer | Protected Mede: Off v H100%




Will be explained in detall ...




Coffee and tea example (3)

« Assume a continuous flow of tea and
coffee drinker, I.e., every 5 minutes
there is request for tea and every 10
minutes there is a request of coffee.

* There are two persons able to
manufacture these drinks (Adam and
Eve) and the production times are as
before.

* Process the requests in FIFO (first-in-
first-out) order.



http://www.spiralandcircle.com/tea break mug front.jpg�

arrival process processing departure process




> CPN Tooels (Version 3.0.2, January 2011

»Tool box | ¥

» Hel Bindar 0 Sim  View
=1 Main

» Options
¥ct fifo.con Q|Q|En|g$| 'a‘a
Step: 0
Timg: 0 1" "Adam"@0.0+++
» Options 1" "Eve"@0.0
= Histaory
¥ Declarations
¥ Standard declarations 3
»colset E

(]

[p="tea"]
1" "Eve"++

T coffee"@0.0+++ measure tea

/1 "tea"@0.0 ; (1]
» colset INT "coffea ++ _ [~ ~[(p,Mtimes()]]
» colset BOOL tea P [i<1000] [

»colset STRING cregte
¥ colset T=string; start demand start prod
¥colset Prod = string timed;

¥colset ProdT = product Prod*T; Pro PL
¥colset PL = list ProdT;

¥ calset Res = string timed; p@-++interarrivaltime(p)
¥colset PR = product ProdT * Res timed;

Tvar p: Prod;

1
1
s
1

end prod

ProdT

(pt)

((p,t),r)@++delay(p,r) [p="caffee"]

¥var r:Res; in production measure coffes
¥yar l:PL;
e PR
¥yar LINT;
¥yart:T;

¥var pt:ProdT;

wfim Aalawln @ —

¥ colset T=string;

¥ colset Prod = string timed;

¥ colset ProdT = produck Prod*T;

¥ colset PL = list ProdT; ¥fun ':|||5|53’I!:D:r:| =
¥ colset Res = string timed,; if p="tea” then

_ o - (if r="Eve" then 2.0 else 5.0) alse
:Ezlfg,[ E?Dd,pmdum ProdT * Res time (if r="Eve" then 12.0 else 4.0} ;

‘Res: ¥fun interarrivaltime(p)=
¥varr.kes; o 1 |
¥var l:PL; if p="tea" then 5.0 else 10.0;

wvar i-INT: ¥fun Mtime() = ModelTime timea():time;
vyvart:T ¥ fun Mtimea5s() = Mu:udeITirne.t_u:nStringl[Mt_irnel[]l]l:51_:rir|g;
¥var pt:ProdT: ¥fun StoR(t:string) = ModelTime.maketime(t): time;

CPN'Replications.nreplications 10




R |
5 1" "adam"@0.0+++
1" "Eve"@0.0

1" "Eve"++
1" "Adam”

[p="tea"]

measure tea

I+1 i
p@++interarrivaltime(p)

0

counter} 1 170
IMNT

1" "coffee"@0.0+++
1" "tea"@0.0 1 1] i
— = [~~[{p,Mtimas(]]] r
1 ff o
I tear : [i<1000] . (P} (p.t)
start create (p,t)
demand o produce start prod end prod ready Prod
Pro L
. ~— (p.t)
p@++interarrivaltimea(p) ((p.0),/)@++delay(p,r) ((p,tlr [p="coffee"] !
measure coffes
PR

- 1" "coffee"@0.0+++

1" "tea"@0.0 1 1°[]

S ;
1 IICDHEEII++ l [EDFMtImESE]]] l:p t]"l I
17 "tea" D [i<1000] (] s /
create
start demand o produce start prod
Fro A L

((p,t),r)@++delay(p,r)

(



R |
5 1" "adam"@0.0+++
1" "Eve"@0.0
[p="tea"]

1" "Eve"++
1" "Adam measurs tea

1" "coffee"@0.0+++
1" "tea"@0.0 _ 1 1]
T |~~~ [(p,Mtimas())] r A
1" "tea” p li<1000] [ (p.t)
create (p.t)
start demand start prod end prod h@@mud
Pro
J’t o
({p.t)r)@++delay(p,r) ((p£hr) [p="caoffee"] ¥

p@-++interarrivaltimeaip)

measure coffes

in production

5 1" "Adam"'@0.0+++
1" "Eve"@0.0
[D:”tea“]

1" "Eve''++
1" "Adam measure tea

A
(p.t)

(p,t):l

start prod end prod

o produce

PL

((p,L).r)

((pt)ri@++delay(p,r)

measure coffee

In production

PR



¥ Monitors

¥ Marking_size_Main'free_1 Mon
e Type: Marking size
»Modes ordered by pages

¥ Marking_size_Main'in production_1
»Type: Marking size
»Modes ordered by pages

¥List length_dec_Main'to produce 1
»Type: List length data collection
»Modes ordered by pages

Ytea flow time
»Type: Data collection
# Nodes ordered by pages
» Predicate
¥ Observer

fun obs (bindelem) =

let
fun obsBindElem (Main'measure_tea (1, {pt}+)) MMEime() - StoR(t)
| obsBindElem _ = ~1.0 —

1§
obsBindElem bindelem
end
» Init function
P Stop
¥ coffee flow time
»Type: Data collection
# Nodes ordered by pages
» Predicate
¥ Observer
fun obs (bindelem) =

d
let
fun obsBindElem (Main'measure_coffee (1, {p,t})) B Mtime() - StoR(t)
| obsBindElem _ = ~1.0 .

measure coffes

i”,jhsamdaem el Tfu.ﬂ Mtime() = ModelTime . timea():time;
end ¥fun Mbimes() = ModelTime tostring(Mtime()): string;

w INit function . . . .
» Stop ¥fun StoR(t:string) = ModelTime.maketimea(t): time;
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Statistics

|90% Half Length [95% Half Length|[99% Half Length|  StD

List_length_dc_Main'to_produce_1

count_iid

2002.000000

0.000000

0.000000

0.000000

0.000000

max_iid

6.400000

0.680381

0.839619

1.206349

1.173788

min_iid

0.000000

0.000000

0.000000

0.000000

0.000000

min_iid

(0.000000

0.000000

0.000000

0.000000

0.000000

0.368205

0.027995

0.034547

0.049637

0.048297

|avrg iid [0.739548 [ 0.094939 |0.117159 |0.168332 |0.163789  |0.589205  [1.103943
\ Marking_size_Main'free_1

| count_id | 2002.000000 [ 0.000000 |0.000000 |0.000000 |0.000000 ||2002 |2002
max_id [2.000000 | 0.000000 0.000000 0.000000 0.000000

Marking size Main'in_production_1

2002.000000

0.000000

0.000000

0.000000

0.000000

2.000000

0.000000

0.000000

0.000000

0.000000

jmin id_|

0.000000

” 0.000000

H 0.000000

H 0.000000

H 0.000000

i |

1.631795

” 0.027995

” 0.034547

H 0.049637

H 0.048297

H 1.586930

” 1.722820

coffee flow_time

count_iid

333.200000

0.244400

0.301600

0.433333

0.421637

avrg_iid

10.485863

0.459849

0.567474

0.815336

0.793329

max_iid

27.600000

2.102408

2.594461

3727674

3.627059

avrg_iid

6.632286

0.386403

0.476837

0.685111

0.666619

max_iid

23.000000

2.116566

2611933

3.952777

3.651484

|min_id [4.000000 [ 0.000000 |0.000000 |0.000000 |0.000000 |4.000000  [[4.000000

sum_iid |[3494.000000 154343970 [190.467026 |273.659521 |266.273043][3260.000000 | 4061.000000
tea_flow_ime

count_iid || 666.800000 [[0.244400 0.301600 0433333 0421637 | 666 667

min #d ||2.000000  ||0.000000 0.000000 0.000000 0.000000 |[2.000000  ][2.000000
|sum_iid [4422.300000( 256812836 [316.917968 |455.341908 |443.051552]4024.000000 | 5403.000000]

PAGE 102




Coffee and tea example (4)

« Assume a continuous flow of tea and
coffee drinker, but now evaluate the
following alternatives:
 LIFO (last-in-first-out) order
« SPT (tea before coffee) order
 FIFO with Eve preferably working on tea

and Adam on coffee.

* Test also your own strategy.

CPN-103
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&> CPN Tools (Version 3.0.2, January 2011’

»Tool box
»Help
» Options
Tt lifa pinder 0
Ste| Main
Time
» Opt
» Hist
¥Decg
¥ 5t

L RE B BE B BE BE B BC B BE BE B IR S A0 A

None

""coffee"@0.0+++
Mtea"@0.0

coffee" ++

iagh p

start

Pro

p@++interarrivaltime(p )

(]
(p,MtimeS())::|

[i<1000]

create
demand to produce star
|Sim Wiew —
«m |
I+1 |

5 1" "Adam"@0.0+++
1" "Eve"@0.0

[p="tea"]

1" "Eve" ++
1" "Adam"

measure tea

DLl

(p,MtimeS())::| A

[i<1000] 0 (p, 1) (p,t)

create {p.t)
PL
(p,t)
((p,t)r)
((p,t)r)@++delay(p,r) o "

[p="coffee"] v

in production measure coffee

PR

CPN'Replications.nreplications 10




ME) CPN Tools Performance Rep

» || + | file///D:/courses/BIS-2011/CPN%20files/coffee-and-tea/ output/reps_3/Perf & | | Q- Google |

5 Apple Yahoo! GoogleMaps YouTube Wikipedia  Mews (10) ¥ Popular v

Statistics
Name | Avrg [90% Half Length [95% Half Length |99% Half Length| S | Mim |  Max

List length_dc_Main'to_produce 1
| count_id [2002.0000000.000000 |0.000000 |0.000000 |0.000000 | 2002 [ 2002 |
max_iid [|4.900000 |0.794300 0.980200 1.408333 1.370320 -
min §d [0.000000 |0.000000 0.000000 0.000000 0.000000 dverage quetic Iength = 0.65+/-0.08 ‘
avg_id [|0.654748  |0.082484 0.101788 0.146248 0142300 |0.489820 [ 1.002095

Marking size Main'free 1

count_iid |2002.000000 | 0.000000 0.000000 0.000000 0.000000 2002 2002
max_iid [|2.000000 |0.000000 0.000000 0.000000 0.000000 . .
min §id [0.000000 |0.000000 0.000000 0.000000 0.000000 average utilization = (2'(035+/'002))/2 ‘
avg_id 0353071 |[0.019841 0.024484 0.035178 0034229 (0311191 0421557 |

Marking_size Main'in_production_1 ‘
count_iid||2002.0000001/0.000000 0.000000 0.000000 0.000000 | 2002 |2002 |
max_iid [|2.000000 |0.000000 0.000000 0.000000 0.000000 - .
min_§id [0.000000 |0.000000 0.000000 0.000000 0.000000 average utilization = (165+/_002)/2 ‘
avrg_iid || 1646929  |0.019841 0.024484 0.035178 0034229 | 1578443 [ 1.688809

coffee_flow_time
|count_iid [333.700000 |[0.279995 |0345526 0496446 |0483046 [333 334 |
a'vrg_?d 10194212 |[0.391368 0.482965 0.693916 0.675186 average flow time coffee= 10.19+/-0.39 ‘
max_iid |91.500000 |[51.205482 63.189744 90.789862 £8.339308 } |
min §id [4.000000 |0.000000 0.000000 0.000000 0.000000 | 4.000000 [ 4.000000
sum iid |[3401.900000(|131.594550 162.393274 233.323670 227.025916[3099.000000/[3921.000000
tea_flow_time ‘
count_iid 666300000 0.279995 0.345526 0.496446 0.483046 | 666 667 |
avig_iid ||6.433586  |0.307211 0.379112 0.544701 0.529998 . _
max_iid |114.500000 |[47.711433 58.877938 84.594739 82.311401 average flow time tea= 6.43+/-0.31
min §d [2.000000 |0.000000 0.000000 0.000000 0.000000 | 2.000000 [ 2.000000
sum iid |[4286.700000|204.666040 252.566602 362.883049 353.088296 | 3809.000000 || 5072.000000 PAGE 105
E!




SPT

‘& CPN Tools (Ve 3.0.2, January 2011

»Tool box Binder 0
inder ; ;
- Sim | \iew
»Help Main Mon

» Options )
vt sptcon | I Y Y e P e e
Step: 0
Time: 0.0 LL | coun | Place | Tran
» Options DC | Tran | Cont | Enab
» Histary
¥ Declarations
¥Standard de
»colset E
» colset INT > 1" "Adam"@0.0+++
» colset BOI 1" "Eve"@0.0
» colset STF [p="tea"]

¥ colset T=¢ 1" "Eve" ++
¥ colset Prg 1" "Adam"

vcolset prg | coffee"@0.0+++
vcolset PL| "tea"@0.0 | . 1 []I
v colset Regy i I~ [(p,MtimeS())] [pt=sel(l),

Tcolset PR, " )
¥varp: Prg [E8 P [i<1000] [1 pt<>null]

¥var r:Res;
¥yar L:PL; start
¥yar i:INT;
¥var tiT;
¥var pt:Prg
¥fun delay| i+1
if p="tea" ) : .
(ifr="Evel P@++interarrivaltime(p)
(if r="Eve!
¥fun intera
if p="tez
¥val null =
¥fun sel2([
sel2((p,t):
¥fun sel(l)
if I=[] thet
else if sell
¥fun rem(x
remix,y: iz valit = () : unit
¥fun Mtime
¥fun Mtime
¥fun StoR(t
¥ Manitors
» Marking_siz

measure tea

A
(p.t)

create
demand

pt

to produce start prod ready

ProdT

Pro

PL
rem(pt,|) (p,t)

(pt,r)

(pt,r)@++delay(pt,r) p="coffee']

in production measure coffee

e
-

—

(=]

PR

CPN'Replications.nreplications 10
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1" "Adam"@0.0++-

2) 1" "Eve"@0.0

1" "Eve" +4
= IIAdamll

/10
[]

PL

17 [(p,MtimeS())]

pt<>null]

start prod

[i<1000]

create
demand

d A

i+1 i

}— %
_....,..._Ln.} 4 4"

¥fun delay((p,t),r) = = 1=]
if p="t=a" then ¥fun rem(x,[1) =[] |
(if r="Eve" then 2.0 else 6.0) else remix,y::z) = if x=y then z else x:irem(x,z);
(if r="Eve" then 12.0 else 4.0) ; ¥ fun Mtime() = ModelTime.time():time;

¥fun interarrivaltime(p)= - _ - - - et 1
T R ¥ fun Moimes() = ModelTime toString(Mtime(])):string;

vval null = ("error” "error"):ProdT: ¥fun StoR(t:string) = ModelTime.maketimel(t): time;
vfun sel2{[]) =null | -
sel2((p L)) =ifp = "tea"” then (p,t] else sel2(l);

¥fun sel(l) =

if 1=[] then null
else if sel2(l) = null then hd(l) else sel2{l); PAGE 107

:Ij (pt.rr}

(pt,r)@++delay(pt,r)




1|+ 8fiIe:,.",.".."D:,"courses,fBIS-EUll,."CPNmﬂfileﬂcoﬁee-and-teafoutputfreps_-’ifperf V] | |Q' Google

=2 Apple Yahoo! GeoogleMaps YouTube Wikipedia MNews(13) ¥ Pepular v

Statistics ‘

E\ Avrg  [90% Half Length| 95% Half Length|99% Half Length| S0 | Min |  Max

List_length_dc_Main'to_produce_1
E\znoz 000000 0.000000 |0.000000 /|0.000000 0.000000 ||2002 2002 |
id [[3.000000 ]0.000000 0.000000 0.000000 0.000000 |3 average queue Iength = 0.23+/-0.02
a [o0.000000 [[0.000000 0.000000 0.000000 0.000000 |0
id [0234327  |0.017611 0.021733 0.031225 0.030383 [0.183508  |[0.296529
- Marking_size Main'free 1
“iid|[2002.000000 [ 0.000000 0.000000 0.000000 0.000000 [ 2002 2002
d ||2.000000 | 0.000000 0.000000 0.000000 0.000000 |2 T ;
4 |[0.000000 [0.000000 0.000000 0.000000 0.000000 |0 average utilization = (2'(059"‘/-002))/2 ‘
E 0589351 | 0.021186 0.026144 0.037564 0036550 0528426 [0.668666 |

Marking size Main'in_production 1 ‘
E 2002.000000 | 0.000000 0.000000 0.000000 0.000000 [ 2002 |2002 |

2.000000 | 0.000000 0.000000 0.000000 0.000000 |2 .- .
j\o 000000 0.000000 |0.000000 |0.000000 |0-000000 [0 average utilization = (141+/-002)/2
@\ 1410649 [0.021186 0.026144 0.037564 lo.036550 1331334 | 1.471574
coffee_flow_time

E\zzlmoooo |5.264537 | 6.496663 9334286 |9.082339 ||201 233 \
id 8437801  0.266928 0.329400 0.473277 0.460502 5
j‘lﬁ 000000 Ho_oooooo ”o_oooooo ”o_oooooo ”o_oooooo 16.0000 average flow time coffee= 8.44+/-0.27
4 |[4000000 | 0.000000 0.000000 0.000000 0.000000 [ 4.000000  |[4.000000
i |[1866.200000 54113218 66.778013 95945421 93355712 [1710.000000/[2052.000000
- tea_flow_time
E 778.600000 5264537 6.496663 9.334286 9.082339 | 767 |799 |
id 4634149 0.088778 0.109556 0.157408 0.153160 | 4.32253 .
«d [12.000000 |0.000000 0.000000 0.000000 0.000000 | 12.0000 average flow time tea= 4.63+/-0.09
; 2.000000 | 0.000000 0.000000 0.000000 0.000000 [2.000000 |2.000000 | |
j |93.368250 |134.149784 | 130.5288813337.000000] 3817.000000
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SMART

> CPN Tooels (Version 3.0.2, January 2011
smart.c|

Binder 0

_ls_ltriz g Main Sim | View Mon
0 | I Y Y e P e e
» History
¥ Declarations LL Coun | Place | Tran
wStandard dec DC | Tran | Cont | Enab
»colset E
» colset INT
»colset BOOI
» calset STRII 1" "Adam"@0.0+++
¥ colset T=st 2 1" "Eve"@D0.0
¥ caolset Prod :

—teg"
¥colset Prod Iy !

¥colset PL =
¥colset Ras ¢ "coffee"@0.0+++

veolset PR = "2 2" @0.0 1 []I

¥var p: Prod o .
¥varr:Res; ' coffee"++ |~ [(p,MtimeS())]

¥var :PL; | "tea" P [i<1000]
¥yar i:INT;
TyartiT; create
¥vyar pt:Prod start demand
¥fun delay((}
if p="tea" t Pra
(if r="Eve"1{
(if r="Eve"1
¥fun interarr
ifp="tea"
¥yal null = (1
¥fun sel2([]J
sel2((p,t)l
if (p="t=a"
(p="coffe
then (p,t) &
¥fun sel(l,r) :
if I=[] then
else if sel2(
¥fun rem(x,[]
remix,y::z)
¥fun Mtime()
¥fun Mtimes| CPN'Replications.nreplications 10
¥fun StoR(t:
¥ Monitors

1" "Eve" ++
1" "Adam"

measure tea

A
(p.t)

pt
end prod ready

ProdT

(p,t)
p@++interarrivaltime(p)

[p="coffee"] v

measure coffee
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| 117
| [(p,MtimeS( )] [pt=sel(l,r), r F
I-iIDDD] [] I:Jti::i'l"'ILJ”]
create
1emand start [:Irl:":l
PL
1 i | rem(pt,|)
fun del £),r) =
Ti1|;12="?eaa?'!:5:[?'|e:rl'|r] (pt,r)@++delay(pt,r)

(if r="Eve" then 2.0 alse 6.0) else
(if r="Eve" then 12.0 alse 4.0} ;

¥fun interarrivalti - U ]
et wfun sel2([1,r) =null |
vval null = ("error”,"error’ SE|E|:|:|:|;‘I::|: :l.rr] =

s e if (p="tea" andalso r="Eve") orelse
= Tes el = E (p="coffee" andalso r="Adam")

(p="coffee" andalsc r=

then (p,t) else sal2(l,r): then |:|:I,t]| alge 5E|E|:|;r:|j-
¥fun sel(l,r) =

if 1=[] then null 1"1_:L”'I sel(l,r] =
else if sel2(l,r) = null the If |=[] thEﬂ r‘|u||

¥fun rem(x[]1) =[] |

rem{x,y:z) = if x=y then  &ls2 If 52l2(],r] = null then hd(l) else selZ2{l,r);
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I_ < | ||+ | filess/D:/ courses/BIS-2011/CPN%20files/ coffee-and-tea/autput/reps_5/Pedf & | | Q~ Google

#5 Apple Yahoo!

Google Maps  YouTube

Wikipedia

News (13} ¥ Popular »

Statistics

Name

=

|90% Half Length||95% Half Length | 99% Half Length |  StD

List_length_dc_Main'to_produce_1

| count_iid| 2002.0000000.000000

” 0.000000

H 0.000000

H 0.000000

max_iid

2.000000

0.000000

0.000000

0.000000

0.000000

min_iid

0.000000

0.000000

0.000000

0.000000

0.000000

avrg_iid

” 0205876

” 0.008632

” 0.010652

Ho_mssos

H 0.014892

Marking_size Main'free 1

2002.000000

0.000000

0.000000

0.000000

0.000000

2.000000

0.000000

0.000000

0.000000

0.000000

0.000000

0.000000

0.000000

0.000000

0.000000

0.582710

0.019606

0.024194

0.034762

0.033824

Marking size Main'in_production_1

| count_iid | 2002.0000000.000000

” 0.000000

H 0.000000

H 0.000000

max_iid

2.000000

0.000000

0.000000

0.000000

0.000000

min_iid

0.000000

0.000000

0.000000

0.000000

0.000000

max_iid

16.000000

0.000000

0.000000

0.000000

0.000000

min_iid

4.000000

0.000000

0.000000

0.000000

0.000000

4.000000

g id 1417200 [0.019606 0.024194 |0.034762 |0.033824

coffee flow_time
count_iid||335.200000 [[9.492353 11.713967 16.830412 16376134 308 362
avg_iid ||7.559776  [0.119357 0.147292 0211626 0.205914

4.000000

sum_iid

2535.100000

92.869367

114.604751

164.661998

160.217526

2228.000000

2778.000000

tea_flow_time

connt_iid

664.800000

9492353

11.713967

16.830412

16.376134

4.327972

0.063419

0.078261

0.112445

0.109410

11.700000

0.391231

0.4827%9%

0.693672

0.674949

2.000000

0.000000

0.000000

0.000000

0.000000

2.000000

2.000000

2876.800000

50.847389

62.747842

90.154945

87.721529

2766.000000

3044.000000
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Compare (1/2)

average queue length = 0.65+/-0.08
average queue length = 0.23+/-0.02 ++

b

average utilization = (1.65+/-0.02)/2

average utilization = (1.41+/-0.02)/2
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Compare (2/2)

average flow time coffee= 10.19+/-0.39

average flow time coffee= 8.44+/-0.27 +

" average flowtime coffee= 75641012 1.

average flow time tea= 6.43+/-0.31

average flow time tea= 4.63+/-0.09 +
| average flowtime tea= 43344005+




Example revisited: Punch card desk

| color STR = string;
| color INT = int;
| color Pat = record Name:STR * Address:STR *
DateOfBirth:STR * Gender:STR;
color Emp = record EmpNo:INT * Experience:INT,;
Icolor EP = product Pat * Emp;
var p:Pat;
Ivar e:Emp;
Ival Klaas = {Name="Klaas", Address="Plein 10",
DateOfBirth="13-Dec-1962", Gender="M"};
lval Ann = {EmpNo0=641112, Experience=7},

wait 1'Klaas /@1\e done
P busy P
Pat Pat
EP




Improved color sets

color Name = string;
color Street = string;
color Number = int;

color Town = string;

color Address =record s:Street * n:Number *
t:Town;

color Day = int with 1..31;

color Month =with Jan | Feb | Mar | Apr | May | Jun |
Jul | Aug | Sep | Oct | Nov | Dec;

color Year = int with 0..2100;

color Date =record d:Day * m:Month * y:Yeatr,

color Gender = with male | female;

color Pat =record name:Name * address:Address *

birthdate:Date * gender:Gender time



Improved color sets (2)

color EmpNo = int with 100000..999999;

color Emp =record empno:EmpNo *
experience:Year timed,

color EP = product Pat * Emp timed;

var p:Pat;

var e:Emp;

val Klaas = {name="Klaas",
address={s="Plein",n=10,t="Unknown"},
birthdate={d=13,m=Dec,y=1962},
gender=male}.Pat;

val Ann = {empno=641112, experience=7}:Emp;

fun d(x:Emp) = if #experience(x) > 5 then 3 else 4;
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Example revisited: Stock keeping system

| color Product = string: |
| color Number = int; I
| color Stockitem = record prod:Product * number:Number; |
| color Stock = list Stockltem:; |
| var x:Stockltem; |
| var s:Stock; |
|fun incrs(x:Stockltem,s:Stock) = if s=[] then [x] else (if (#¥prod(hd(s)))=(#prod(x)) |
then {prod=(#prod(hd(s))),number=((#number(hd(s)))+#number(x)))}::tl(s) |
| else hd(s):: incrs(x,tl(s))); |
fun decrs(x:Stockltem,s:Stock)= incrs({prod=(#prod(x)),number=(~(#number(x)))},s);
Ifun check(s:Stock)= if s=[] then true else if (#¥number(hd(s)))<0 then false |
| else check(tl(s)); |
val initstock = [{prod="bike", number=4}{prod="wheel", number=2}, |
| {prod="bell", number=3}, {prod="steering wheel", number=3}, |
|_{prod="frame", number=2}; |

1 {prod="bell",
in number=3} s stock 'initstock ¢ LCheck(descrs(x,s))] out
< > X
x g @ « D
Stockltem : INCrs(x,s) ook descrs(x,s) Stk
increase toc decrease tockltem
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Store

« Place stock is a so-called store, i.e., it will always
contain a single token.

* Only the value of the token matters (not its
presence).

« Stores that aggregate elements are always of type
list.

« Drawback: complex functions/inscriptions

« Advantage: easy to query the individual items as a
whole, e.g., taking the sum of things ...
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Function "totalstock"

fun totalstock(s:Stock) =
If s=[ ]
then O
else (#number(hd(s)))+totalstock(tl(s));

| color Product = string; |
| color Number = int; [
| color Stockltem = record prod:Product * number:Number; |
| color Stock = list Stockltem; |
| var x:Stockltem; |
| var s:Stock; |
|fun incrs(x:Stockltem,s:Stock) = if s=[] then [X] else (if (#prod(hd(s)))=(#prod(x)) |

then {prod=(#prod(hd(s))),number=((#number(hd(s)))+@#number(x)))}::tl(s) |
| else hd(s):: incrs(x,tl(s))); |

fun decrs(x:Stockltem,s:Stock)= incrs({prod=(#prod(x)),number=(~(#number(x)))},s);

Ifun check(s:Stock)= if s=[] then true else if (#number(hd(s)))<0 then false I
I else check(tl(s)); [
| val initstock = [{prod="bike", number=4},{prod="wheel", number=2}, |
| {prod="bell", number=3}, {prod="steering wheel", number=3}, |
|_{prod="frame", number=2}; _ I

1*{prod="bell",
in number=3} s  stock _1initstock ¢ [check(descrs(x.s))] out

X

decrease Stockltem
CPN-119
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Alternative model

I———————————————————————————————l

color Product = string;
color Number = int;
| color Stockitem = product Product*Number;
| var p:Product;
| var x:Number;
| var y:Number;

e e e e e o o o o o e o e o o — — — — — — — — — — — — — — — —
1 ("bike",4)++
1 ("wheel",2)++
1 ("bell",3)++

1 ("steering wheel",3)++
“("bell" 1 ("frame",2 -
in 1 ("bell”.2) (py) Stock ( )(p y) y>=x] out
(P (p.x+y) il B (P.y-X)
Stockltem increase ' Stockltem ' decrease Stockltem

Note the simplicity/elegance of the arc inscriptions.
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Example: Signing documents

Documents need to be signed by persons.
Four persons: Tim, Sue, Clare and John.

Each document requires three signatures.

No two signhatures of the same person.

Work in progress is limited to five documents.
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Signing documents: Declarations

____________________________ -
| color Doc = string;

| color Person = string;

| color Signatures = list Person;

| color SignedDoc = product Doc * Person,;

| color BlackToken = unit;

| var d:Doc;

| var p:Person;

| var s:Signatures;

| fun notin(p:Person,s:Signatures) =

| if s=[] then true else if p=hd(s) then false else notin(p,tl(s));
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Signing documents: Network structure

[count(s)<3 andalso notin(p,s)]

person p
.. o sign
P
Person 1" Tim"++ A
1""Sue"++
1"Clare™+  (d,s)| |(d,p:s)
1"John"
unsigned_doc oile [count(s)>=3] signed_doc
d, d,s d,s
§) .
free 5 () 0
Y
BlackToken
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Exercise

* Replace place free by a place always holding one
token. e .

| color Doc = string;
color Person = string;
I color Signatures = list Person;
color SignedDoc = product Doc * Person;
| color BlackToken = unit;
| var d:Doc;
[ var p:Person;
| var s:Signatures;
| fun notin(p:Person,s:Signatures) =
| if s=[] then true else if p=hd(s) then false else notin(p,ti(s));

[count(s)<3 andalso notin(p,s)]

person
sign
Person 1‘"Tim"+-E
1™"Sue"++
1™Clare"++ (d,s) (d,p::s)
1™"John"
unsigned_doc

[count(s)>=3] signed_doc
(d.s)

(ds)

@m Pe
Q—d’

Doc accept SignedDoc release SignedDoc
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Example: Thermostat system

* At any point the room has a temperature (initially 15 degrees
centigrade).

 Thereis a heater to warm up the house and there is a door which
opens every hour such that part of the warmth escapes.

 When the door opens the temperature in the room suddenly
drops by three degrees centigrade.

 The heater has a capacity of heating the room 1 degree
centigrade every 15 minutes.

 When the heater would be switched on the whole time the
temperature would continue to rise by 1 degree per hour.
Therefore, there is a control system, i.e., the thermostat, which
switches off the heater. The thermostat uses the following rules.

« If the temperature drops below 18, the heater is switched on.
« If the temperature rises above 22, the heater is switched off.
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CPN model of thermostat system

| color Temp = string;
| color B = unit;

| color BT = B timed,
| var t:Temp;

var a:B;

0

[t>22] [t<18]

switch_off switch_on
heater 10 | \ 4 ¢ p door 1°0
<! >
t+1 t-3
BT b@+15 warm_up cool_down b@+60 BT
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Exercise

« Describe the room temperature in time starting in the
Initial state shown, i.e., play a timed, colored token
game".

« Extend the model such that there is a day program and
a night program. From midnight to 8am, the thermostat
tries to keep the temperature between 14 and 18
degrees centigrade. (If the temperature drops below 14
the heater is switched on. If the temperature rises
above 18 the heater is switched off.) From 8am to
midnight, the temperature is kept between 18 and 22
degrees, like before.
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WARNING

It IS not sufficient to understand the
(process) models. You have to be able to
design them yourself !



sector O sector 1

Exercise:

Train system

sector 2

sector 6

7 sectors (tracks)
2 trains: A and B

When moving to a new
sector both this sector
and the next one should

sector 3

sector 4

be empty.
’ T_ralns_ drive in one » Model as a classical Petri
direction. net.

« Model in terms of CPN
without folding the tracks.

* Model as a CPN with
folding the tracks (i.e., only

two places).




Unfolded

‘oo CPN Tools (Version 3.0.2, January 2011]

¥ Tool box
Auxiliary | Sim  View I
Craate Binder 0
WEpo M| p
Monitoring
Net
Simulation
State space
Style
View
»Help
» Options
wtrain unfoldes
Step: 0
Time: 0
» Options
» History
¥ Declarations
- Standard
¥ colset Set
¥colset Uni
¥vart: Seg
» Monitars
main

fo 1) 1°0)
UNIT

None trainA (free  trainB



Partially folded

»Tool box
»Help
» Options
¥train part unfolded.cpn
Step: O
Time: 0O
» Options
» Histary
¥Declarations
» Standard declarations
¥colset Sector= with A | B;
¥ colset Unit = unit;
¥var t: Sector;
= Monitars
main

Binder 0
main

Sim | Wiew

«mpo/p | p [y

Sectar




Trains and tracks folded

“w CPN Tools (Version 3.0.2, January 2011) L e e S

= Tool box
= Help Sim  \Miew
= Options |
rtrain folded.con
Step: O
Tlrm_a: 4 Binder 0
- Options main
» History
¥Declarations
- Standard declarations
rval n=7
¥ colset Sector = int with 0..n-1;
¥ colset State = with busy | free; 17 (0,busy)++
¥ colset 5S = product Sector*State; 17(1,free)++
¥ colset Train = with &|B; 17 (2 free)++ 1 (s,busy)++
¥colset TS = product Train * Sector; 1 Ei,]kc:lusxlrl]++ 1 [(§+1) mad 7 free)++
:::;:1511Ei2-+§:if1t-m I(Shrags | (s+2)mod 7.free) (t,(s+1) mod 7) 17 (A,0)++
Lo ' 1°(6,free) 17 (B,3)
= Monitors
main
@ move @
55 TS5
17 (0,busy)++ 5 1 (A0)++
1° (1 free)++ 1" (s,free)++ (t.s) Y 1°(B,3)
1°(2free)++ 17 ((s+1) mad 7,busyi++
7. 1°(3,busyj++ 1" ((s+2) med 7 free)
17 (4 free)++
17 (5 free)++
1° (6 frae)




Exercise: Philosophers

5 philosophers
5 chopsticks

« Each philosopheris
either thinking or eating.

* For eating two chopsticks
are needed.

* Chopsticks need to be
shared among neighbors. « Model as a classical Petri

- Both chopsticks are net.
taken and released at the < Model in terms of CPN
same time. using only three places

and two transitions.
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CPN Tools (Version 3.0.2, January 2011
»Tool box
“HE'P Binder 0
» Options Page
¥ DiningPhilosophersClassic.con
Step: 0
Time: 0
» Options
» Histary
¥Declarations
¥colset UNIT = unit;
» Monitors
Page

Sim | Wiew

Do M| oy /m

Put Down
Chopstickss

Thinks 17
UNIT

Put Down 4]
Chopsticks4 0

Free
Chopstickd

0

UNIT
4]

Take
Chopsticks4

0

Put Down
Chopsticks1 0]
%
0]
0]
()
Think1 11

LINIT

Take
Chopsticks1

Free
Chopstick

Take
Chopsticks2

Chopsticksz

Put Down
Chopsticks2

Put Down
Chopsticksz




I-T;:u:I box

» Help _ _
» Options Sim Wiew

¥ DiningPhilosophersColored.con .
Step: 100000 SimashO «|.|’0| N | k |hkclm

Time: 0

» Options

» History

¥ Dedarations
Fvaln
¥colset PH = int with 1..n; PH.all{)
¥colset C5 = int with 1..n;

Think 13

¥yvarp: PH; 1" 244
¥ fun Chopsticks(i) = PH 1 44+
[i,if i=n then 1 else i+1]; b 1'5

+ Monitors
Page

Take _
Chopsticks Chopsticks(p)

Put Down Chopsticks(p)
Chopsticks

J




Exercise: Philosophers (2)

5 philosophers

5 chopsticks

* Each philosopher is either
thinking or eating.

« For eating two chopsticks

are needed.

 Chopsticks need to be
shared among neighbors.

« First the right chopstick is
taken. Then the second one
IS taken.

 The two chopstick are
released in reversed order.

* Model in terms of CPN.
* Are deadlocks possible?
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Initial state

‘g CPM Tools (Version 3.0.2, January 20

¥Tool box
Auxiliary

Create . I Si Wi 55
Binder 0 m —

Hierarchy -

Manitoring main « . ’O

Met

Simulation

State space

Style

View
»Help
» Options PH.all()

T DiningPhilosophersWithDeadlock.cpn : ] Release
Stan: 0 Take First think Second
= Chopstick Chopstick
Time: 0 P

PH
» Options F 3
» History
¥ Declarations
*valn
¥coolset PH = int with 1..n;
¥colset C5 = int with 1.0}
¥yarp: PH;
¥fun r(p:PH) = p:CS; Unused
¥fun I(p:PH) = if p<n then (p+1) else 1:CS; hopstick
» Monitaors
main Ccs

Cs.allf

h 4
Take Release
Second First

Chopstick Chopstick




4 |s eating, 3 took his right chopstick

“ggr CPM Toels (Version 3.0.2, January 20

¥Tocol box
Auxiliary

Create ; ISim Wiew 55 I
Binder 0

Hierarchy .

Maonitoring main «|.|’O| H | k |mJII.I

Met
Simulation
State space
Style L 1++
View 1 2++

» Help 3 15

» Options PH.all(}

¥ DiningPhilosophersyithDeadlock.cpn Take First , Release
Step: 2 Chaopstick think iecan_dk
Time: 0 o Chopstic
» Options F 3
= History
¥ Declarations
+valn
¥colset PH = int with 1..n;
¥ colset C5 = int with 1..n;
¥yar p: PH;
¥fun r{p:PH) = p:C5;
¥fun I{p:PH) = if p<n then (p+1) else 1:C5; starting1 ﬂ] }I;JQ;:t?Cdk
» Monitors PH
main CcSs

C5.allf

Y

Take Release
Sacond First
Chopstick . Chopstick




Deadlock

‘2 CPM Toels (Version 3.0.2, January 20

¥Tool box
Auxiliary

Create . I g Wi 55 I
Binder O 'm g MEW

Hierarchy -

Manitoring ol «|.|’O| H | k |kk[]ll.l
et

Simulation
State space

Style
View »

= Help
" opene ' pH-alli Release
- .
D|r;|tr;|;[|JFI’h°|ISDSDpherszthDeadIDck.cpn Eike First > think P cacond
o opstick P Chopstick
Time: 0 PH L
» Options F 3
= Histary
¥Declarations rp)
= val n P r(p) p
¥colset PH = int with 1..n; 1 144
¥ colset CS = int with 1..n; 1 2++4
¥yarp: PH; 1 3++ el
¥fun r(p:PH) = p:CS; ] 1: 44+ Unused ]
¥fun I(p:PH) = if p<n then (p+1) else 1:C5; startings ) 1°5 haopstick ending
» Monitors PH PH
main Cs
I(p) I(p)
P p
h 4
Take p p Release
Second eat P First
Chopstick BH Chopstick

None




From state space report

« State Space | |
- Nodes: 392 || 2

— Arcs: 1415 °~’f§ §ro | 5P

2 1?'6‘ Wi

» One home marking o
Take First think ' 3] Fise;iuarig

e On e d ead m ar kl n g Chopstick = O Chopstick

PH
rip)
P rip) P
17 1++
1" 2++
. Cs.all
1 3++ [
17 4++
. Unused :
@ 15 hopstick ending
PH PH
C5
I(p) I(p)
p P
Take p P Release
Second gat P First
Chopstick o Chopstick




Adding philosophers (n=8)

Nodes: 14158
Arcs: 81848

-
% CPN Tools (Version 3.0.2, January 20 EE
¥ Tool box
Auxiliary ' l
| Create ind Sim | VMiew S5 |
Hierarchy Binder 0 .
q i main Enter
Maonitoring 55 Q’ o o |:|
Met
Simulation B oég §:§0 ¢
State space
Style L 1]
View % ®.
2 s
» Help e
» Options PH.all))
¥ DiningPhilosophersWithDeadlocks.cpn Take First p Release
. d Second
Step: 0 Chopstick ) Chonstick
Time: 0 PH e
» Options F 3
- History ,
¥ Declarations i ,%H' r(p)
¥valn=8; p 0 ‘3':: r(p) p
¥colset PH = int with 1..n; 1" dgt
¥colset CS = int with 1..n; 1" 54+
¥var p: PH; 1" 6++ 3l
¥fun r(p:PH) = p:CS; ) 1: T++ nusad ]
¥fun I{p:PH) = if p<n then (p+1) else 1:CS; startingg) 1°B hopstick ending
= Maonitors PH PH
main Ccs
lp) I(p)
p p
Y
Take p p Release
Second e First
Chopstick - Chopstick




Exercise: Philosophers (3)

5 philosophers
5 chopsticks
Each philosopher is either
thinking or eating.

For eating two chopsticks
are needed.

Chopsticks need to be
shared among neighbors.

First the one chopstick

(either left or right) is taken.
Then the other one is taken.

Also released in arbitrary
order.

* Model in terms of CPN.
* Are deadlocks possible?
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Model

‘g% CPN Tools (Versi

¥Toaol box

ALxiliary
Create
Hierarchy
Manitaring

Sim | View

|
(Hpo My

State space
Style
View
»Help
= Options
¥ DiningPhilosophersWithDeadlock-AnyOrder.cpn
Step: O
Time: 0
= Options
» History
¥ Declarations
= valn
¥coolset PH = int with 1..n;
¥colset C5 = int with 1..n;
¥var p: PH;
¥fun r{p:PH) = p:C5;
¥fun l(p:PH) = if p<n then (p+1) else 1:CS;
= Maonitors
main

2}
Take First Take First -
LChopstick RChopstick b
P p rip)
[{s)]
@ startk
PH PH
r(p)
P P I(p)
Take Take P
Second Second
RChopstick LChopstick

p
PH alll) Release Release
Second Second
- RChopstick LChopstick
r(p)
P P
[{s)]
C5.allf
Unused
Chopsticks 3) endL endR
PH PH
C5
rip)
P P
) \
Release Release
eat P First First
o LChopstick RChopstick




State space analysis

» 1473 states
« 6270 transitions

* two dead mar

KINgsS

I{p)

I(p)

p
Take First Take First
LChopstick RChopstick

p p
17 1++
1724+
17 3++
17 4++
startL 31. 5 startk
PH PH
p p
Y
Take Take
Secand Second
RChopstick LChopstick
p

-,
p
,ﬂ" . Take First
_\-._tin_k_ LChopstick
p
Ccs.ally
Unused startL
Chopsticl
PH
C3
p
Y
Take
Second
=at RChopstick
p

Take First
-

RChopstick P

p r(p)

17 1++
1724+
startRIS) 17 3++
1" 4++
Pli-5

P 1{=))

Take p

Second
LChopstick

think

Cs.all(

Unused
Chopsticks

Cs

eat

p
PH.all) Release Release
Second Secand
RChopstick LChopstick
: ‘Erfafrf’,/"’ A
r(p)
p p
[{=)]
endL andr
PH PH
r(p)
p p
I(p)
Rdezgghhhﬁﬁhkﬂa Release
P First First
o LChopstick RChopstick

=l




Tradeoff

* More information In e More information In

tokens network
— color sets, functions, etc. — possibly spaghetti networks to
- behavior may be hidden encode simple things
in “code” - behavior may be
- extreme case: all iIncomprehensible
behavior folded into one — cannot be parameterized
place and one transition - extreme case: (infinite) classical
Petri net
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More on functions: Recursion

o “fun fac(x:INT) = if x>1 then x*fac(x-1) else 1” is a
recursive function since the function is expressed in
terms of itself.

 Two cases:

e fac(x) = x*fac(x-1)
e fac(l) =1

« fac(10)=10*fac(9)=10*9*fac(8)=10*9*8*fac(7)= ... =

10*9*8*7*6*5*4*3*2*1 = 3628800
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Recursion (1)

color Product = string;
color Number = int;
color Stockltem =record prod:Product * number:Number;
color Stock = list Stockltem;
fun totalstock(s:Stock) =
ifs=1]
then O ° O
else (#number(hd(s)))+totalstock(tl(s));

Recursion
in length of
list

Also see http://cpntools.org/documentation/concepts/colors/declarations/colorsets/record_colour_sets
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Recursion (2)

Instead of
sum the
maximum is
taken

fun maxstock(s:Stock) = Q
ifs =[] O
O
then O

else if (#number(hd(s))) >= maxstock(tl(s)) then #number(hd(s))

else maxstock(tl(s));

"apple” 301
"orange" 504
"pear” 423 # 504
“banana” 134
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. Function
Recursion (3) calls other

function

fun maxstockname(s:Stock) = O
Ifs =[]
then "no product found" o
else if (#number(hd(s)))=maxstock(tl(s)) then #prod(hd(s))

O

else maxstockname(tl(s));

"apple” 301
"orange" 504
"pear"” 423 # "orange"
“banana” 134
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Function

Recursion (4) has two

arguments

fun enoughstock(s:Stock,n:Number) =
ifs=1[]
then [ ]
else if #number(hd(s)))>= n then hd(s)::enoughstock(tl(s),n)

else enoughstock(tl(s),n);

"apple” 301 "orange" 504
"orange" 504 N=400 [wpeqr: 423
"pear"” 423 #

“banana” 134
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Recursion (5)

Length of
list rather
than list
itself

fun enoughstockn(s:Stock,n:Number) =

ifs=1] Q

then O O
O
else if (#number(hd(s)))>= n then 1+enoughstockn(tl(s),n)

else enoughstockn(tl(s),n);
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More on functions: Pattern matching

fun lenlistl(s:Stock) =
ifs=1]
then O

else 1+lenlist(tl(s));

:
funlenlist2([]) =0 - °
lenlist2(si::s) = 1+lenlist2(s); ° °©

No explicit typing!!!
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Pattern matching (1)

fun totalstock(s:Stock) =

Ifs=1]

then O

else (#number(hd(s)))+totalstock(tl(s));

fun totalstock([ | : Stock) =0 |

totalstock(si::s) = (#number(si))+totalstock(s);
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Pattern matching (2)

fun maxstock(s:Stock) =
iIf s=[]
then O
else if (#number(hd(s))) >= maxstock(tl(s)) then #number(hd(s))

else maxstock(tl(s));

fun maxstock([ ]:Stock) =0 |
maxstock(si::s) = if (#number(si))>maxstock(s) then #number(si)

else maxstock(s);
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Pattern matching (3)

fun Incrs(x:Stockltem,[ ]:Stock) = [x]
incrs (X,(si::s)) =
it (#prod(si))=(#prod(x))
then {prod=(#prod(si)),
number=((#number(si))+(#number(x)))}
..incrs(Xx,s)

else (si::incrs(x,s));

apple 301 x={prod="apple", apple 321
"orange” 504 number=20} "orange” 504
"pear" 423 ) | pear’ 423

“banana” 134 “banana” 134




Pattern matching (3)

fun Incrs(x:Stockltem,[ ]:Stock) = [x]
incrs (X,(si::s)) =
it (#prod(si))=(#prod(x))
then {prod=(#prod(si)),
number=((#number(si))+(#number(x)))}
..incrs(Xx,s)

else (si::incrs(x,s));

"apple" 301
"apple" 301 x={prod="Xx" "orange" 504
"orange” 504 number=20} "pear" 423
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Pattern matching (4)

fun reverse([]) =[] | reverse(x::y) = reverse(y)**[X];

fun elt([ ], a) = false | elt((x::xs), a) = a=x orelse elt(xs, a);

fun del(a,[]) =[] | del(a,(x::xs)) = if a=x then xs else x::(del(a,xs));

fun intersect([],ys) =[] |

intersect(xs,[])=[1]

intersect ((x::xs), ys) = if elt(ys,x)
then x::(intersect(xs,(del(x,ys))))
else intersect(xs, ys);
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Example SUdOku for 9 rows and

columns

colset Index = int with 0..8; /_ T PT——
colset Cel = int with ~1..9; technical reason,

_ normal values
colset Cels = list Cel; are 1..9

colset Pos = product Index * Index;
colset Val = product Pos * Cel,
colset Sudoku = list Val,

Write an ML function to solve a Sudoku assuming that
in each step there is a "deterministic candidate", i.e.,
no backtracking needed.
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O values are not inserted

O

fun readcell(x,i,j) = if x=[ ] then [ ] else if
hd(x) = 0 then readcell(tl(x),i,j+1) else
((i,)),hd(x))::readcell(tl(x),i,j+1);

fun readrow(x,i) =if x=[ ] then [ ] else

[6,0,0, 0,8,0, 0,0,9],
[017101 410161 01810]1
[0,0,0, 5,0,1, 0,0,0],

[0,1,7, 2,0,9, 8,5,0], readcell(hd(x),i,0)* readrow(tl(x),i1+1);
[2,0,0, 0,0,0, 0,0,1], fun read(x) = readrow(x,0):Sudoku;
[0,8,4,1,0,3, 6,7,0], °

O
[0,0,0, 3,0,8, 0,0,0], O

[014101 910151 01110]1
[8,0,0, 0,7,0, 0,0,5]

O values are empty

to map “string” (list of lists)
representation to list of ((i,j),c)
values
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Useful functions

fundom([]) =[]] dom((x,y)::l) =x::dom(l);

fun elt([ ], a) = false | elt((x::xs), @) = a=x orelse elt(xs,
a);

fun fmap([ ],z) =0 | fmap((x,y)::l,z) = if x=z then y else
fmap(l,z);

fun sdiff([ ],z) =[] | sdiff(x::y,z) = if elt(z,x) then
sdiff(y,z) else x::sdiff(y,z);

infix sdiff; e
O

difference of two
sets
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Basic functions

same block values in the block
containing (i,]

fun row([ ],kd =[] ] row(((i,j),c)::s,k) =if i=k then
c..row(s,k) else row(s,k) : Cels;©

fun column([ ],k) =[] | column(((ig}),c)::s,k) = if j=k then
c::.column(s,k) else°column@(s k) : Cels;

fun de(l j) = (| d'\é?’) = (J div 3);

fun blg . 0Ck(((' all cell values in row k
all cell values in 0loc , ; e A
S

val uni =[1,2,3,4,5,6,7,8,9]: Cels:

fun free(s,i,J) = ((uni sdiff row(s,i)) sdiff column(s,j)) sdiff
block(s,i,)) : Cels; -

O

remaining options
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Possible moves

given an s of type
Sudoku, all undefined
positions are returned

all possible
values of type

Pos, i.e., list of all

ells

fun allpos() = Pos all(); -

fun undef(s) = allpos() sdiff dom(s)

fun analyzel(s,[ ]) =[] | analyzel(s,(i,))::l) =
((1,)),free(s,i,]))::analyzel(s,l);

fun analyz?(s) = analyzel(s,undef(s));

O
O

possible moves per
position
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add error entry
(no options left)

add entry with just
one possible move ¢

O
funnew([])=[]] © ©

new(((i,j).[ 1)::s) = ((i,)),~1)::néw(s) |

new(((i,i).[c])::S) = ((.).c)::new(s) |
new(((i,j),c::cs)::s) = new(s);e © © g

fun solve(s) =
If new(analyze(s)) =[]
then s
else solve(new(aonalyze(s))""s);
“O
repeatedly call solve until no

entries can be added (done or
non-deterministic choice needed




Sort results

fun sord(((x1,y1),z1),((x2,y2),z2)) = (x1 < x2) orelse
(x1=x2 andalso y1l <y?2);

fun solver(s) = sort sord (solve(s));

O

O
O

sort function is built in
“sort It_fun I” sorts list | using the function It_fun to
determine when one element in the list is less than
another.

See http://cpntools.org/documentation/concepts/colors/declarations/colorsets/list_colour_sets
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Generate string (just for presentation)

fun resultl(s,) = if i>=81 then "--------------mm———- \n" else
(Int.toString(fmap(s,(i div 9, 1 mod 9))) * (if i mod 9 =8
then "\n" else " " )" resultl(s,i+1));

fun result(s) =
P\ cme e \n"~resultl(solver(s),0);
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 CPN Tools (Version 3.0.2, January 2011)

+Tool box
= Help
bﬂﬁﬁps Sim Wiew |58
¥sudoku.cpn ¢
Q|Q | ||
Time: 0 En % =
+ Options
= History
¥ Declarations
I Standard declarations
Ttypes
¥colset Index = int with 0..8;
¥colset Cel = int with ~1..9;
¥colset Cels = list Cel;
¥colset Pos = product Index * Index;
¥colset Val = product Pos * Cel;
¥colset Sudoku = list Wal;
¥valuni =[1,2,2,4,5,6,7,8,9]: Cels;
= valuas
Tfunctions
¥iun domi[]) =[] | dom((x,y)::1) = = :dom(l);
¥fun elt([], a) = false |
elt{(x::xs), a) = a=x orelse elt(xs, a);
¥fun fmap([],z) = 0 | fmap((x,y)::1,z) = if x=z then y else fmap(l,z);
¥fun sdiff([1,z) = [] | sdiff(x::y,z) = if elt(z %) then sdiff(y,z) else . :sdiff(y,z);
T¥infix sdiff;
¥fun readeell(x,i,j) = if x=[] then [] else if hd(x) = 0 then readcell(tl(x),i,j+1) else ((i,j),hd(x)): readeeall(ti{x]),i,j+1];
¥fun readrow(x,i) = if x=[] then [] else readcell{hd(x),i,0)™"readrow(tl{x),i+1];
¥fun read(x) = readrowi(x,0):Sudoku;
¥iun row([1,k) = [1 | row(((i,j),c)::s,k) = if i=k then c:irow(s,k) else row(s,k) : Cels;
¥fun column([],k) = [1 | eolumni((i,j),c)::s,k) = if j=k then c::column(s,k) else columnis,k) : Cels;
¥fun deli,j) = (i div 3) = (j div 2);
¥fun block([1,i,j) = [] | block{{{i1,j1),c)::5,,]) = if de(i,i1) andalso de(j,j1) then c::block(s,i,j] else block(s,i,j) : Cels;
¥fun free(s,i,j) = ((uni sdiff row(s,i)) sdiff column(s,j)) sdiff block(s,i,j) : Cels;
¥fun allpos() = Paos.all();
¥fun undefis) = allpos() sdiff dom(s);
¥fun analyzel(s,[1) =[] | analyzei(s,(ij)::1) = ({i,]).free(s,i,i)):; analyzel(s,l);
¥fun analyze(s) = analyzel(s,undef(s));
¥fun new([1) =[] |
newl((i,j),[1)::s) = ([ij),~1])::new(s] |
newl((i,j)[c])::s) = ({ij).c)::new(s] |
newll((i,j)ccs)iis) = new(s);
¥fun solvel(s) = If newl(analyza(s)) = [] then s else solve(newl(analyze(s))™"™s);
¥iun sord(((x1,51),21),0(x2,¥2),22]) = (k1 < x2) orelse (x1=x2 andalso y1 < y2);
¥fun solver(s) = sort sord (solve(s));

¥fun resultlis,i) = if iz= 81 then "-——-mmmmmmmmmm W' else (InttoString(frmap(s,( div 9, i mad 9))) =~
(if i mod 9@ = & then "\n" else " " )™ resultl({s,i+1));
¥fun result(s) = "\n-——mmmmmmmm e Wt resultl(solver(s),0);
» Maonitors

main

Create

OO | 7
N

LY

Binder 0
main [ val ¥5

*** raplace v1 by ¥2, v3, v4 or your own sudoku ***

result(read(vs))

1STRING
1
1265840937
475239861 read(vl
BO216754°2
751945328
348725196 5
952318475 a2
237801654
65194527832 readtvE
S5B4673219
" read(v4

[1,2] sdiff [2,3]

Mone




Create

O | 7

P “ o~ =
) OO

Mmoo
x LY -, L

1% CPN Tools (Version 3.0.2, January 2011

+ Tool box
»Help

V L L LY
Al ~N O
oR T m m om
T Moy OO
o

_mmv i R ) Ty
*

— H H
| ¥
=L

Sﬁ =]

w g

— ]

w

Jof
c

o

£z =

V| =}

- =
5 =

o s G

(T3} = ot
[ =
(=] m
: &
= =
) 3
= (5]
o z
[y
=
=
0
—
=
i}
|5
m
(=8
i}

_
*
*
o *
(.
LiE]
Tc
c
= -
<
o o
e &
o %)
- o=
.
Ca G Mn_,;
(== B T W -~
4 )
£¢.-a38%
E= ] Wy
w cwm b
c w_w_&umx:m
o 4 o =
= .mw.,el.nﬁ_.m__dﬂ
T g E=@g:c 5T
moL=a B xa
I R T
2] b= = u_ T
P = = T T =
2o Suua>;,
o = [ Y N I R
a E= R
w m O L & B G & G —
ScﬂmnWFHEDDDDDDau
c2doplofllBooLooUo=m
SagEaBgasrErrErrS
BEB0FOT o4k »
O @ A &P
i

|

L W |

O W N
o Oy O
Mmoo

jon Rl o i - 8
O o
OO
ocon

M~ M O

] ] e

STRING

i
1
&
B
0

e Ty

LY L

- L

L L

- LY

L -

-

read
read
reac

i B o I < I I T B iy s
00D =k 0 O = L oD
(o e T R B o
il e T v R Mt
s M Yl ol oV I W VT B
(TN e Wil ol v ol
\D LD 00— 6D e hosE
(S e BTl T M I W s
— = GO WD

- s . e
= S ———
o oom o oy P
O %
o ooo + oo
O .
oM oo~ oo
- e e . -
wOo oo —
A S L
oo oog oo
e e
oow Mmoo ool
Ay -
no+ ocao-d oooo

1 r—r—

o C o
n o
M~ Oo

0 <+ O
NO O
o v o

[SES SR PR o |

reac

block

note the
middle

fwo 1'sin

4

o n a nn A o n .
—r—— ——— e e —
[ NP N=) oo oo ooo [=1l=
B WE S S, L= LSS, &
[=N=]T"] oo oo ooo (=]
LS LSS, L= LSS, &
oot OO o000 o000 (=l
“ nom " non “ n = “ n o n -
oo 0 = coC oo ooo (=]t
UL L L= =L L L
Lo oo oo OO0 o g
LIElE Sl L=l =L s
L — =0 S TP = - = = =k
o oo " non “ n . " non -
cown DMmeo oo ooo 2 2$ogd
ol R R S 8 255 o A
(=N =] oo ooo ooo (=]
L E RS 255 s =
A0 ..Tooo ooo ooo.. Tuog
— e P o —_——— [ T—T— e )
» ]



More Information

« About Standard ML:

 Robin Milner, Mads Tofte, Robert Harper, and David MacQueen.The Definition of
Standard ML: Revised 1997. The MIT Press, 1997.

 J.D. Ullman. Elements of ML Programming (ML 97 edition). Prentice-Hall, 1998.
o http://www.standardml.org/Basis/ (for functions)

* About CPN:

« K.Jensen and L.M. Kristensen. Coloured Petri Nets: Modelling and Validation of
Concurrent Systems, Springer-Verlag, 2009.

« W. van der Aalst and C. Stahl. Modeling Business Processes: A Petri Net-Oriented
Approach. MIT Press, 2011.

K. Jensen: Coloured Petri Nets. Basic Concepts, Analysis Methods and Practical
Use. Volume 1, Basic Concepts. Monographs in Theoretical Computer Science,
Springer-Verlag, 1997.

K. Jensen: Coloured Petri Nets. Basic Concepts, Analysis Methods and Practical
Use. Volume 2, Analysis Methods. Monographs in Theoretical Computer Science,
Springer-Verlag, 1997.

K. Jensen: Coloured Petri Nets. Basic Concepts, Analysis Methods and Practical
Use. Volume 3, Practical Use. Monographs in Theoretical Computer Science,
Springer-Verlag, 1997.

K. Jensen and G. Rozenberg (eds.): High-level Petri Nets. Theory and Application.

Springer-Verlag, 1991. _
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